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弊社製品をお買い上げいただき、誠にありがとうございます。ご質問・ご要望については、ご遠慮

なく販売店までご連絡ください。 

著作権 

Copyright 2015-2018 Zhejiang Uniview Technologies Co., Ltd. 無断複写転載等を禁ず。当社の事前の書面

による許可なく、いかなる形式または手段でも、本マニュアルの全体または一部を複写・複製・翻

訳・配布することは一切できません。 

 

商標に関する確認 

 など Uniview の商標やロゴは Zhejiang Uniview Technologies Co., Ltd.の所有物です。本書に記

載されている他の商標、企業名、製品名は、すべて、それぞれの所有者に帰属します。 

免責事項 

 
注意！ 

デフォルトパスワードは最初のログインに使用されます。アカウントのセキュリティを確保す

るため、最初のログイン後に、パスワードを変更してください。強力なパスワード 

（8文字以上）を設定するよう推奨します。 

 

 該当法規の規定により、本書で説明されている製品（ハードウェア、ソフトウェア、ファーム

ウェア、ドキュメントを含む）は「現状のまま」で提供されます。 

 本書の内容について完全性や正確性を期していますが、本書内の記述、情報、推奨事項は、明

示・暗示を問わず一切の保証なしに提供されます。本書の技術的誤謬や誤植について、当社は

一切責任を負いません。本書の内容は予告なく変更されることがあります。更新された記述内

容は、本書の新版に追加されます。 

 本書の使用ならびにそれによって生ずる結果は、すべて使用者が責任を負うものとします。当

社では、収益の損失、業務の中断、データやドキュメントの喪失等、本製品の使用に起因する

いかなる特別損害、結果的損害、偶発的損害、間接的損害に関して、一切責任を負いません。 

 動画および音声による監視を規定する法規は、国ごとによって異なります。監視目的で本製品

を使用する前に、お住まいの地域の法規を確認してください。装置の違法な操作に起因するい

かなる結果に関しても、当社では一切責任を負いません。 

 本書に記載されている機能は単なる参考に過ぎず、実際のバージョンや機種と異なる可能性が

あります。本書に掲載のスクリーンショットは、特定の要件やユーザの好みに応じてカスタマ

イズされている場合があります。その結果、例や機能の一部が、お使いのモニターの表示内容

と異なることがあります。 

 本書は多数の製品機種のガイドとして作成されており、特定の製品を意図したものではありま

せん。 

 物理環境などの不確定要素により、実際の値と本書の参考値が食い違うことがあります。最終

的な解釈は当社の一存に委ねられます。 



 

環境保護 

本製品は環境保全の要件を満たすよう設計されています。適切な方法で保管・使用・廃棄するため、

各国の法規や規則を遵守してください。 

記号 

本書には下表の記号が使用されています。危険な状況を回避するため、各記号の指示に従い、製品

を正しく使用してください。 

記号 説明 

 警告！ 
重要な安全上の指示が記載され、使用者が怪我をする原因となる状況が示してあ

ります。 

 注意！ 
すなわち、使用者の注意を要し、不適切な方法で使用すると、製品が破損したり

動作不良になる状況を意味します。 

 ヒント！ 製品の使用に関する役に立つ情報や追加情報を意味します。 
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1  ネットワーク接続 

PC からネットワークカメラ（別名 IP カメラ、IPC）にアクセスする前に、ネットワークケーブルを

使用して直接、または、スイッチやルータを介して、PC にネットワークカメラを接続する必要が

あります。 

 

シールド付ツイストペア（STP）ケーブルを使用して、ネットワークカメラのネットワークインタ

ーフェースと PC を接続します。 

 

シールド付ツイストペア（STP）ケーブルを使用して、カメラのネットワークインターフェースと

スイッチまたはルータを接続します。 

2  ログイン 

準備 

クイックガイドに従って設置を完了したら、カメラを電源に接続して起動します。カメラが起動す

ると、ウェブブラウザまたは EZStation クライアントソフトウェアをインストールした PC クライア

ントから、カメラにアクセスできます。ウェブブラウザとして Internet Explorer （IE） を推奨しま

す。EZStation の詳細については、EZStation ユーザマニュアルを参照してください。 

次に、Microsoft Windows7 オペレーティングシステムにインストールした IEを例にとって説明し

ます。 

ログイン前のチェック 

 カメラが正常に動作している。 

 PC とカメラとのネットワーク接続が正常に動作している。 

 PC に Internet Explorer バージョン 10.0 以降がインストールされている。 

 （オプション）解像度が 1440 x 900 に設定されている。 

Network cable

IPC PC

IPC PCSwitch or Router

Network cable Network cable
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信頼できるサイトとして IP アドレスを追加する 

 

1.13

 

1

2



3 

 
ヒント！ 

この例の IP アドレス 192.168.1.13 は、デフォルト IP アドレスです。アドレスを変更した場合は、実

際のカメラのアドレスと入れ換えてください。 

 

（オプション）ユーザアクセス管理設定の変更 

カメラにアクセスする前に、手順に従って、User Account Control Settings を Never notify に設定し

ます。 

 

ウェブインターフェースへのログイン 

カメラのデフォルトの静的 IP アドレスは 192.168.1.13 で、デフォルトのサブネットマスクは

255.255.255.0 です。 

デフォルトでは DHCP が起動します。ネットワークで DHCP サーバが使用されている場合、カメラ

の IP アドレスが動的に割り当てられるので、正しい IP アドレスを使用してログインする必要があ

ります。 EZStation クライアントを使用して、カメラの動的 IP アドレスを表示します。 

以下で、 IE を例に取り上げてログイン手順を説明します。 

1. アドレスバーに、カメラの正しい IP アドレスを入力して、ログインページを表示させます。 

 

2. 初めてログインする際には、システムの指示に従って ActiveX をインストールしてください。

インストールを完了するには、ブラウザを閉じる必要があります。 

1

2

3

4
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ヒント！ 

 手動で ActiveX をロードするには、アドレスバーに http: //IP address/ActiveX/Setup.exe を記

入して、 Enter を押します。 

 デフォルトパスワードは最初のログインに使用されます。アカウントのセキュリティを確

保するため、最初のログイン後に、パスワードを変更してください。強力なパスワード 

（8 文字以上）を設定するよう推奨します。 

 カメラは、ログインの失敗回数を制限して、不正なアクセスから保護しています。6 回続

けてログインが失敗すると、自動的にカメラは 10 分間ロックされます。 

 

3. ユーザの初回ログイン時に、画面にプライバシーポリシーが表示されます。プライバシーポリ

シーを読んだら、「プライバシーポリシーを読んで同意しました」ボックスにチェックマーク

を入れ、「OK」ボタンをクリックし、次の手順に進みます。  

 

 

4. ユーザ名とパスワードを入力し、Login をクリックします。初めてログインする際には、デフ

ォルトユーザ名「admin」とパスワード “123456” を使用してください。 

 Live View を選択してログインすると、ログイン時にライブビューが表示されます。それ以外の

場合は、ライブビューウィンドウで、手動でライブビデオを起動する必要があります。 

 Save Password を選択してログインすると、ログインするたびにパスワードを入力しなくても

済みます。ただし、セキュリティを確保するため、Save Password を選択しないよう推奨しま

す。 

 Username と Password のテキストボックスと Save Password チェックボックスをクリアするに

は、 Reset をクリックします。 
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ウェブインターフェースについて 

デフォルトでは、ウェブインターフェースにログインしたときに、ライブビューウィンドウが表示

されます。下にその一例が挙げてあります。 

 

番号 説明 

1 メニュー 

2 

PTZ コントロールエリア 

注意：  

このエリアは、PTZ ドームカメラと PTZ カメラで使用できます。 

3 ライブビューウィンドウ 

4 ライブビューツールバー 

 

初期設定 

デバイスにログインしたら、次のような初期設定を実行してください。 

項目 説明 

1. TCP/IP イーサネット。 
実際のネットワークに基づいて、デバイス IP とネットワー

クパラメータを再設定します。 

2. 一旦ログアウトしてから、新しい 

IP アドレスを使用して再度ログイン

します。 

- 

3. システム時刻を設定する。 実際の状況に応じてシステム時刻を設定します。 

4. （オプション）管理サーバを設定す

る。 
実際のネットワークに基づいて、管理サーバを設定します。 

5. （オプション）写真保管用のサーバ

を設定します。 

実際のネットワークに基づいて、写真保管用のサーバを設

定します。 

1

2

3

4



6 

項目 説明 

6. OSD を設定する。 
必要に応じて、時刻など、画面に表示される情報を設定し

ます。 

7. （オプション）ユーザを管理する。 
必要に応じて、デフォルトパスワードを変更し、共通ユー

ザを追加します。 

 

初期設定を終了するとライブビデオを閲覧することができます。必要に応じて他のパラメータも設

定してください。 

 
ヒント！ 

 表示されたライブビューインターフェースとパラメータと値の範囲は、モデルによって異

なることがあります。詳細については、実際のウェブインターフェースをご覧ください。 

 グレーアウトされているパラメータは変更できません。実際の設定については、ウェブイ

ンターフェースをご覧ください。 

 初めてログインする際は、パスワードを変更するよう推奨されます。パスワード変更の詳

細については、セキュリティを参照してください。 

 

3  パラメータの設定 

ローカルパラメータ 

PC にローカルパラメータを設定します。 

 
ヒント！ 

ローカルパラメータはモデルによって異なることがあります。詳細については、実際のウェブインタ

ーフェースをご覧ください。 
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1. [Setup] > [Common] > [Local Settings] を選択します。 

 

2. 必要に応じて設定を変更します。次の表に、主なパラメータが説明されています。 

パラメータ 説明 

インテリ

ジェント

マーク 

未トリガーター

ゲット 

有効にすると、カメラに、ターゲット（顔検知が有効な場合は顔）のオ

ンスクリーンマークが表示され、それが追跡されます。 

ビデオ 

処理モード 

 リアルタイム優先：ネットワークの状況が良好な場合に推奨されます。 

 スムージング優先：ライブビデオでタイムラグを小さくしたい場合に

推奨されます。 

 超低遅延：ライブビデオでタイムラグを最小限に抑えたい場合に推奨

されます。 

プロトコル 
メディアストリームを送信して PC でデコードする際に使用されるプロ

トコルを設定します。 

録画とス

ナップシ

ョット： 

録画 

 時間による分割：コンピュータ内の各録画ファイルの録画済みビデオ

の再生時間です。例：2分。 

 サイズによる分割：コンピュータに保存されている各録画ファイルの

サイズです。例：5M。 

録画上書き 

 上書き：コンピュータ内で割り当てられているストレージスペースを

使い果たした場合、カメラは、新しい録画ファイル用のスペースを作

るため、既存の録画ファイルを削除します。 

 完全停止：コンピュータ内で割り当てられているストレージスペース

が一杯になると、自動的に録画が停止します。 

ファイルフォル

ダ 

 スナップショットと録画の保存パスです。最大パス長は 260 バイトで

す。上限を上回ると、ライブビューでの録画やスナップショットが失

敗し、画面にメッセージが表示されます。 

 

3. Save をクリックします。 
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ネットワークの設定 

イーサネット 

カメラが他のデバイスと通信できるように、カメラの IP アドレスなどの通信設定を変更します。 

 
ヒント！ 

 IP アドレスを変更した後は、新しい IP アドレスを使用してログインする必要があります。 

 ドメイン名でデバイスにアクセスする際には、DNS （ドメイン名システム）サーバの設定

が適用されます。 

 

静的アドレス 

1. [Setup] > [Network] > [Network] とクリックします。 

 

2. Obtain IP Addressドロップダウンリストから Static を選択します。 

3. IP アドレス、サブネットマスク、デフォルトゲートウェイアドレスを入力します。ネットワー

ク内で、カメラの IP アドレスが一意になっている必要があります。 

4. Save をクリックします。 

PPPoE 

 
ヒント！ 

この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧ください。 

 

カメラが Point to Point over Ethernet（PPPoE）を介してネットワークに接続される場合、IP 取得モ

ードとして PPPoE を選択する必要があります。 
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1. [Setup] > [Network] > [Network] とクリックします。 

 

2. Obtain IP Address ドロップダウンリストから PPPoE を選択します。 

3. インターネットサービスプロバイダー（ISP）から提供されたユーザ名とパスワードを入力し

ます。 

4. Save をクリックします。 

DHCP 

カメラの出荷時には、デフォルトでダイナミック・ホスト・コンフィギュレーション・プロトコル

（DHCP）が有効になっています。ネットワークに DHCP サーバが展開されている場合、カメラは、

自動的に、DHCP サーバから IP アドレスを取得することができます。 

手動で DHCP を設定するには、以下の手順に従ってください。  

1. [Setup] > [Network] > [Network] とクリックします。 

 

2. Obtain IP Address ドロップダウンリストから DHCP を選択します。 

3. Save をクリックします。 
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IPv6 

1. [Setup] > [Network] > [Network] とクリックします。 

 

2. デフォルトでは、IPv6 モードは Manual に設定されています。 

3. IPv6 アドレスを入力し、プレフィックスの長さとデフォルトゲートウェイを設定します。ネッ

トワークで、IP アドレスが一意になっている必要があります。 

4. Save をクリックします。 

Wi-Fi 

 
ヒント！ 

一部のモデルではこの機能はサポートされません。詳細については、実際のモデルをご覧ください。 

1. [Setup] > [Network] > [Network] とクリックします。Wi-Fi タブをクリックします。 

 

2. Sniffer を選択します。 

3. Save をクリックします。 

一部のデバイスでは、Wi-Fi ネットワークを検索して接続することができます。 
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1. [Setup] > [Network] > [Network] と選択します。Wi-Fi Mode で Wi-Fi を選択します。 

 

2. シグナル強度が表示されます。Adaptive Streams を起動します。このページには、他にも Wi-Fi 

ネットワークがあることが表示されます。再度 Wi-Fi ネットワークを検索するには、Search を

クリックします。 

3. Wi-Fi ネットワークリストで SSID をクリックします。対応するネットワークの情報が表示され

ます。 

4. Save をクリックします。 

5. Wi-Fi Mode が Wi-Fi Hotspot に設定されると、カメラは、他のデバイスの Wi-Fi ホットスポット

として機能することができます。 

 

6. Save をクリックします。 



12 

ポート 

 
ヒント！ 

この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧ください。 

1. [Setup] > [Network] > [Port] とクリックします。 

 

2. 関連するポート番号を設定します。 

3. Save をクリックします。 

FTP 

すべてのスナップショット（顔検知を除く）は、一般的な FTP サービスを通じて保存されます。 

FTPを設定すると、ネットワークカメラから、指定の FTP サーバに、スナップショットをアップロ

ードすることができます。 

一般 

1. [Setup] > [Storage] > [FTP] とクリックします。General タブに進みます。 

 

2. FTP サーバの IPアドレスとポート、FTPサーバへの画像アップロードに使用されるユーザ名と

パスワードを設定し、Upload Images、Overwrite Storage を選択し、Overwrite At（画像上書き

閾値）を設定します。一部のデバイスでは、FTP テストをサポートしています。その場合、 

FTP 設定を正しく完了した後に FTP をテストすることができます。 

3. FTP サーバにスナップショットを保存するパスと、ファイル名フォーマットを設定します。た

とえば、パスを、 Preset No.\\IP Address\\Date\\Hour(s) と設定し、ファイル名を 

Preset No.-PTZ Zoom-PTZ Latitude-PTZ Longitude.jpg と設定します。 

4. Save をクリックします。 
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スマート 

この機能を使用して、顔認識などのスマート機能で撮影したスナップショットを保存します。 

FTPを使用するには、[Setup] > [System] > [Server] > [Intelligent Server] とクリックし、FTP へのプラッ

トフォーム通信タイプを設定します。 

1. [Setup] > [Storage] > [FTP] とクリックします。Smart タブに進みます。 

 

2. FTP サーバの IPアドレスとポート、FTP サーバへの画像アップロードに使用されるユーザ名と

パスワードを設定します。 

3. FTP サーバにスナップショットを保存するパスと、ファイル名フォーマットを設定します。た

と え ば 、 パ ス を 、 Preset No.\\IP Address\\Date と 設 定 し 、 フ ァ イ ル 名 を 

Preset No.-PTZ Latitude-PTZ Longitude-PTZ Zoom.jpg と設定します。 

4. Save をクリックします。 
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E メール 

電子メールを設定すると、アラームがトリガーされたときに、指定のメールアドレスにメッセージ

を送信することができます。 

1. [Setup] > [Network] > [E-mail] とクリックします。 

 

2. 送信者と受信者の関連パラメータを設定します。一部のデバイスでは、電子メールテストをサ

ポートしています。受信者のアドレスを設定した後に、電子メールをテストすることができま

す。次の表に、主なパラメータが説明されています。 

パラメータ 説明 

TLS/SSL 

有効にすると、プライバシーを保護するために、電子メールは、TLS（トランスポート

・レイヤー・セキュリティ）または（セキュア・ソケット・レイヤー）で暗号化され

ます。 

電子メールは、まず、SSL 接続を通じて送信しようとします。SMTP サーバが SSL をサ

ポートする場合、電子メールは SSL 接続を通じて送信されます。サポートされない場

合は、STARTTLS を使用して送信しようとします。 

画像の添付 
有効にすると、電子メールには、キャプチャ間隔に従って撮影された、3 枚のインス

タントスナップショットが添付されます。 

ユーザ名/パス

ワード 

登録電子メールアドレスのユーザ名とパスワードです。パスワードには、\ / : の各特

殊文字が使用できます。* ? ’ ” <> | % & 

 

3. Save をクリックします。 
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ポートマッピング 

1. [Setup] > [Network] > [Port] とクリックします。Port Mapping タブに進みます。 

 

2. Port Mapping を有効にし、マッピングタイプを選択します。Manual が選択された場合、外部ポ

ートを設定する必要があります（外部 IP はカメラによって自動的に取得されます）。設定され

たポートが占有されている場合、Status が非アクティブと表示されます。 

3. Save をクリックします。 

DNS 

1. [Setup] > [Network] > [DNS] とクリックします。 

 

2. DNS サーバアドレスを設定します。 

3. Save をクリックします。 

DDNS 

 
ヒント！ 

この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧くだ

さい。 

 

1. [Setup] > [Network] > [DDNS] とクリックします。 

 

2. DDNS Service を有効にします。 

3. DDNS タイプ：DynDNS、NO-IP、EZDDNS を選択します。 

4. サーバアドレス、ドメイン名、ユーザ名、パスワードなど、他の設定を完了します。 

5. Save をクリックします。 
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EZCloud 

 
ヒント！ 

 この機能は一部のモデルでは利用できません。 

 スマートフォン（iOS または Android）で QR コードをスキャンして、アプリをダウンロー

ドします。 

 インストールしたら、アプリを実行してカメラを追加します。詳しい手順については、ア

プリのオンラインヘルプを参照してください。 

 

1. [Setup] > [Network] > [EZ Cloud] とクリックします。 

 

2. On を選択してクラウドサービスを有効にします。 

3. Save をクリックします。 

 

SNMP 

中央サーバで設定を転送する必要があるカメラでは、SNMPv3 が推奨されます。カメラと中央サー

バの両方が SNMPv3 をサポートする必要があります。 

 
ヒント！ 

 SNMPv3（デフォルト）と SNMPv2 の 2 つのオプションが利用できます。 

 SNMPv2 を選択する場合、潜在的なリスクに関するオンスクリーンメッセージが表示され、

継続したいかどうか尋ねられます。 

 

1. [Setup] > [Network] > [SNMP] とクリックします。 
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2. SNMPv3 を選択して、設定を完了します。 

3. Save をクリックします。 

SNMPv2 設定ページで、カメラと中央サーバとの間の双方向認証として、Read-Only Community 

Name が使用されます。デフォルトの名前は public ですが、必要に応じて変更できます。 

Read-Only Community Name を変更した場合、中央サーバと同じ名前に変更しなければ、双方向

認証は完了しません。 

 

 

802.1x 

802.1x は、ネットワークに接続する際に、デバイス（カメラなど）に認証を要求します。認証を受

けたデバイスのみがネットワークに接続できます。これによってセキュリティが向上します。 

1. [Setup] > [Network] > [802.1x] とクリックします。 

 

2. On を選択し、他の設定を完了します。 

3. Save をクリックします。 

QoS 

QoS（サービスの質）は、指定のネットワーク通信のサービスを向上する機能です。ネッ

トワークの遅延やブロックなどの問題を回避するためのネットワークセキュリティ機構

として、QoS が使用されます。ネットワークが過負荷になった場合でも、QoS によって、

重要なサービスが遅延したり中断することなく、効率的にネットワークが動作します。 

1. [Setup] > [Network] > [QoS] とクリックします。 
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2. 各サービスに優先レベル（0～63）を設定します。現在、QoS によって、音声とビデオ、アラ

ームレポート、設定管理、FTP 転送に、別々の優先順位を割り当てることができます。値が大

きいほど、優先順位が高くなります。たとえば、音声とビデオを 60 に、アラームレポートと

設定管理を 0 に、FTP を 4 に設定した場合、ネットワークが混雑しても、優先順位の高い音声

とビデオが、スムーズに動作します。 

3. Save をクリックします。 

 
注意：  

QoS を使用する際には、スイッチが QoS モードをサポートすることを確認してください。 

 

 

 

画像の設定 

画像調整 

 
ヒント！ 

 表示される画像パラメータと許可される値の範囲は、カメラモデルによって異なることが

あります。お使いのカメラの実際のパラメータと値の範囲については、ウェブインターフ

ェースをご覧ください。スライダーを動かして設定を調整するか、テキストボックスに値

を直接入力することができます。 

 Default をクリックすると、デフォルト画像設定が復元されます。 

 

シーンの設定 

ライブビデオのシーンに応じて適切な画像エフェクトが実現できるように、画像パラメータを設定

します。 

[Setup] > [Image] > [Image] とクリックします。 

一部のモデルでは、シーン管理ページが以下のように表示され、ドロップダウンリストから希望の

シーンを選択することができます。 
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一部のモデルでは、シーン管理ページが以下のように表示され、以下の手順でシーンを設定するこ

とができます。 

 

1. Scenes をクリックします。 

2. シーンを選択し、シーン切り換えパラメータを設定します。次の表に、主なパラメータが説明

されています。 

列 説明 

現在 

使用中のシーンを表示します。 

注意：  

 オプションボタンを選択してシーンを切り換え、そのシーンに対応する画像パラメ

ータを表示させます。 

 Enable Auto Switching を選択すると、カメラは自動的に現在のシーンを切り換え

ます。 

シーン名 

現在のシーンの名前です。デバイスは複数のプリセットシーンモードを提供します。

シーンを 1 つ選択すると、対応する画像パラメータが表示されます。実際のニーズに

合わせて画像設定を調整できます。 

 一般：屋外のシーンに推奨されます。 

 屋内：屋内のシーンに推奨されます。 

 高感度：暗い環境に推奨されます。 

 高照度補正：路上のヘッドライトや公園のスポットライトなどの強い光を抑制でき

ます。車両ナンバープレートを取得する際に推奨されます。 

 WDR：窓、コリドー、正面玄関など、外が明るく中が暗い、コントラストの大きい

シーンに推奨されます。 

 カスタム：必要に応じてシーンを設定します。 

 顔：複雑なシーンの中で移動する顔を取得します。 

自動切換 

シーンを自動切換リストに追加するかどうかが表示されます。 

注意：  

Auto Switching が選択された場合、シーン切換条件が満足されると、システムは自動

的にシーンを切り換えます。デフォルトでは、自動切換リストにデフォルトシーンが

含まれます。 

設定 

をクリックして、スケジュール、照明、現在の仰角（PTZ と水平方向との角度）な

どの自動切換条件を設定します。すなわち、設定された時間内で、照明条件と現在の

仰角が設定条件を満足すると、自動切換が動作します。開始値と終了値がともに 0 に

設定されている場合、条件は無効になります。 
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3. シーンを選択して  をクリックすると、そのシーンがデフォルトシーンとして設定されます。 

4. 自動切換が有効になっている場合、非デフォルトシーンへの切換条件が満足されると、カメラ

は自動的にそのシーンに切り換わります。それ以外の場合は、カメラはデフォルトシーン設定

で撮影し続けます。自動切換が有効でない場合、カメラは現在のシーン設定で撮影し続けます。 

 
ヒント！ 

 自動切換が有効になっている（シーンが設定できない）場合、デバイスは、設定シーン間

を切り換えます。有効になっていない場合、デバイスは現在のシーンを撮影し続けます。

非デフォルトシーンがトリガーされない場合、デバイスはデフォルトシーン設定で撮影し

続けます。 

 複数の非デフォルトシーンがトリガーされると、デバイスは、番号が最も小さいシーンに

切り換わります (1 から 5 まで)。 

 

画像補正 

 
ヒント！ 

この機能はモデルによって異なることがあります。詳細については、実際のウェブインターフェース

をご覧ください。  

 

1. [Setup] > [Image] > [Image] とクリックし、Image Enhancement をクリックします。 

 

2. スライダーで設定を変更します。数値を直接入力することもできます。次の表に、主なパラメ

ータが説明されています。 

項目 説明 

輝度 

画像の明るさを設定します。 

  

低照度 高照度 
 

彩度 

これは、色に含まれる色彩の濃さです。 

  

低彩度 高彩度 
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項目 説明 

コントラスト 

最も黒いピクセルと最も白いピクセルとの間の差を設定します。 

  

低コントラスト 高コントラスト 
 

鮮明度 

画像中の物体の輪郭のコントラストです。 

  

低鮮明度 高鮮明度 
 

2D ノイズリダ

クション 
画像のノイズを低減します。この機能によって画像がぼやけることがあります。 

3D ノイズリダ

クション 

画像のノイズを低減します。この機能によって動きがぼやけることがあります 

（アプリケーションによってはゴーストが発生する）。 

画像回転 

画像の回転。  

  

一般 垂直方向に反転 

  

水平方向に反転 180° 
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項目 説明 

  

90° 時計回り 90° 反時計回り 
 

 

3. このエリアをデフォルト設定に復元するには Default をクリックします。 

露光 

 
ヒント！ 

 この機能はモデルによって異なることがあります。詳細については、実際のウェブインタ

ーフェースをご覧ください。 

 デフォルト設定は「シーン順応型」です。変更する必要がない場合は、デフォルト設定を

使用してください。 

 

1. [Setup] > [Image] > [Image] とクリックし、Exposure をクリックします。 

 

カメラのモデルによっては、このページは次のように表示されます。 
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2. 必要に応じてパラメータを設定します。次の表に、主なパラメータが説明されています。 

パラメータ 説明 

露光モード 

適切な露光モードを選択して、希望の露光効果を達成します。 

 自動: カメラは、環境に応じて自動的に露光を調整します。 

 カスタム：必要に応じて露光を設定します。 

 屋内 50Hz：シャッタースピードを制限して縞模様の発生を低減します。 

 屋内 60Hz：シャッタースピードを制限して縞模様の発生を低減します。 

 マニュアル：シャッター、ゲイン、絞りを手動で設定して、画質を微調整します。 

 動体ブレの低減：最小シャッタースピードを制御して、動いている顔を撮影した際

の動体ブレを低減します。 

シャッター 

シャッターは、レンズへの入射光を制御します。物体が高速で移動するシーンでは、

シャッタースピードを速くします。物体が低速で変化するシーンでは、シャッタース

ピードを遅くします。 

注意：  

 Exposure Mode を Manual または Shutter Priority に設定して、シャッタースピード

を設定することができます。  

 Slow Shutter が Off に設定されていると、シャッタースピードの逆数を、フレーム

レートよりも大きくする必要があります。 

利得（dB） 

光量条件に応じてカメラが標準ビデオ信号を出力できるように、画像信号を制御し

ます。 

注意：  

Exposure Mode を Manual または Shutter Priority に設定した場合にのみ、このパラメー

タを設定することができます。 

スローシャッ

ター 

暗いシーンで画像の明るさが改善されます。 

注意：  

Exposure Mode が Shutter Priority に設定されておらず、Image Stabilizer が無効になっ

ている場合にのみ、このパラメータを設定することができます。 

最も遅いシャ

ッター 

露光中は、カメラのシャッタースピードを最も遅い値に設定します。 

注意：  

Slow Shutter が On に設定されている場合にのみ、このパラメータを設定することがで

きます。 
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パラメータ 説明 

補正 

希望の効果が得られるように、必要に応じて補正値を調整します。 

注意：  

Exposure Mode が Manual に設定されていない場合にのみ、このパラメータを設定する

ことができます。 

測光コントロ

ール 

カメラによる光量の測定方法を設定します。 

 中心重み平均測定：主に画像の中心部の光量を測定します。 

 評価測定：画像中のカスタマイズされたエリアの光量を測定します。 

 ハイライト補正：画像中の過剰露光部分の明るさを無視します。ただし、この設定

を選択すると、画像全体が暗くなります。 

 顔測定：光量が少ない条件で、顔画面で撮影された顔の明るさを制御して、画質を

調整します。 

注意：  

Exposure Mode が Manual に設定されていない場合にのみ、このパラメータを設定する

ことができます。 

デイ/ナイトモ

ード 

 自動: カメラは、環境光の条件に応じて、最適な画像を出力します。このモードで

は、カメラは、デイモードとナイトモードを自動的に切り換えることができます。 

 ナイト：カメラは、既存の光を使用して高画質の白黒画像を撮影します。 

 デイ：カメラは、既存の光を使用して高画質のカラー画像を撮影します。 

デイ /ナイト 

感度 

デイモードとナイトモードを切り替える光のしきい値です。感度の値が大きいほど、

光の変化に対する感度が大きくなり、デイモードとナイトモードが簡単に切り替わり

ます。 

注意：  

Day/Night Mode が Automatic に設定されている場合にのみ、このパラメータを設定す

ることができます。 

デイ /ナイト 

切替 

切替条件を満たしてから、カメラがデイモードとナイトモードを切り換えるまでの時

間を設定します。 

注意：  

Day/Night Mode が Automatic に設定されている場合にのみ、このパラメータを設定す

ることができます。 

WDR 

同一画像内で明るいエリアと暗いエリアを区別できるように、WDR を有効にします。 

注意： 

Exposure Mode が Customize にも Manual にも設定されておらず、Image Stabilizer が無

効になっている場合にのみ、このパラメータを設定することができます。 

WDR レベル 

WDR 機能を有効にすると、WDR レベルを調整して画質を改善することができます。 

注意：  

シーン内で明るいエリアと暗いエリアのコントラストが強い場合、レベル 7 以上を使

用します。コントラストが弱い場合、WDR を無効にするか、レベル 1～6 を使用する

よう推奨されます。 

WDR による縞

模様の抑制 

これを有効にすると、カメラは、光の周波数に応じてスローシャッターの頻度を自動

的に調整して、画像中に現れる縞模様を最小限に抑制することできます。 

 

3. デフォルトに復元するには Default をクリックします。 
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スマート照明 

 
ヒント！ 

この機能はモデルによって異なることがあります。詳細については、実際のウェブインターフェース

をご覧ください。  

 

1. [Setup] > [Image] > [Image] とクリックし、Smart Illumination をクリックします。 

 

2. 適切な IR コントロールモードを選択し、パラメータを設定します。次の表に、主なパラメー

タが説明されています。 

パラメータ 説明 

照明タイプ 

 赤外線：カメラは赤外線照明を使用します。 

 ホワイトライト：カメラはホワイトライト照明を使用します。 

注意：  

Control Mode が Manual に設定されていると、カメラは照明レベルを 0～1000 で設定

することができます。 

コントロール

モード 

 グローバルモード：カメラは、均衡のとれた画像効果を達成できるように、IR 照明

と露光を調整します。このオプションを選択すると、画像の一部が露光オーバーに

なることがあります。このオプションは、監視対象範囲と画像の明るさが最優先さ

れる場合に推奨されます。 

 露光オーバー抑制：カメラは、部分的な露光オーバーを防止するように、IR 照明と

露光を調整します。このオプションを選択すると、画像の一部が暗くなることがあ

ります。このオプションは、画像の中央部分をクリアに表示することと、露光オー

バーを制御することが最優先される場合に推奨されます。 

 道路：このモードでは画面全体が強い照明で照らされるので、道路など、広範なシ

ーンを監視する場合に推奨されます。 

 公園：このモードでは画面全体に均一に光が当たるので、工業団地など、多数の障

害物がある狭い範囲を監視する場合に推奨されます。 

 マニュアル：このモードでは、IR 照明の強さを手動で制御することができます。 

 屋内：このモードは屋内シーンに適用される際に推奨されます。 

照明レベル 

IR光の強度を設定します。値が大きいほど、光の強度が強くなります。0 では、IR 光

が消えます。 

 近距離照明レベル：広角シーンでは、最初にこのパラメータを設定するよう推奨さ

れます。 

 中距離照明レベル：中程度の焦点距離が必要なシーンでは、最初にこのパラメータ

を設定するよう推奨されます。 

 遠距離照明レベル：遠景が必要なシーンでは、最初にこのパラメータを設定するよ

う推奨されます。 

注意：  

Control Mode が Manual に設定されている場合にのみ、このパラメータを設定するこ

とができます。 

 

3. デフォルトに復元するには Default をクリックします。 
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フォーカス  

 
ヒント！ 

この機能はモデルによって異なることがあります。詳細については、実際のモデルをご覧ください。  

 

1. [Setup] > [Image] > [Image] とクリックし、Focus をクリックします。 

 

2. 必要に応じてフォーカスモードを選択します。 

パラメータ 説明 

フォーカスモ

ード 

 オートフォーカス：カメラは、現在の光の条件に応じて、自動的にフォーカスを合

わせます。 

 マニュアルフォーカス：必要に応じて手動でカメラを調整します。 

 ワンクリックフォーカス：カメラが回転したり、画像を拡大縮小したり、プリセッ

トが選択されても、カメラは被写体にフォーカスを合わせます。 

 ワンクリックフォーカス（IR）：このフォーカスモードにすると、夜間や暗い屋内

などの低照度条件で、IR 光が点灯して画質が向上します。 

シーン 

 一般: 道路や工業団地など、一般的なシーンに使用します。 

 長距離：道路を長距離にわたって監視する際に使用します。たとえば、カメラを 

30 メートルの高さに取り付けて、遠くの交差点を監視する際に使用します。 

 

3. デフォルトに復元するには Default をクリックします。 

ホワイトバランス 

ホワイトバランスとは、人間の目に最適な画像を出力するように、異なる色温度で画像に投影され

る不自然な色を相殺するプロセスです。 

 
ヒント！ 

この機能はモデルによって異なることがあります。詳細については、実際のウェブインターフェース

をご覧ください。 

 

1. [Setup] > [Image] > [Image] とクリックし、White Balance をクリックします。 
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2. 必要に応じてホワイトバランスモードを選択します。次の表に、主なパラメータが説明されて

います。 

パラメータ 説明 

ホワイトバラ

ンス 

画像の赤または青のオフセットを調整します：  

 Auto/Auto2：カメラは、照明条件（色が青みがかる）に応じて、自動的に赤または

青のオフセットを調整します。Auto モードにしても画像が不自然に赤っぽくまた

は青っぽくなる場合は、Auto2 を試してください。 

 微調整：手動で赤や青のオフセットが調整できます。 

 屋外：色温度範囲が比較的広い屋外環境に適しています。 

 ロック状態：現在の色温度を変更せずにロックします。 

 ナトリウムランプ：カメラは、照明条件（色が赤みがかる）に応じて、自動的に

赤や青のオフセットを調整します。 

赤 の オ フ セ 

ット 

手動で赤のオフセットが調整できます。 

注意：  

White Balance が Fine Tune に設定されている場合にのみ、このパラメータを設定する

ことができます。 

青 の オ フ セ 

ット 

手動で青のオフセットが調整できます。 

注意：  

White Balance が Fine Tune に設定されている場合にのみ、このパラメータを設定する

ことができます。 

 

3. デフォルトに復元するには Default をクリックします。 

高度 

デフォグ機能を使用して、霧やもやの条件下で撮影した画像の明瞭性を調整します。 

1. [Setup] > [Image] > [Image] とクリックし、Advanced をクリックします。 

 

 
ヒント！ 

 このパラメータは、WDR をオフにした場合にのみ設定することができます。 

 デフォグは、一部のカメラモデルでのみサポートされます。Defog を On に設定したとき

に、デフォッグ強度レベル 6～9 でデフォッグが有効になり、デフォッグ強度を 5 から 

6 に設定すると画像がカラーから白黒に変化します。Defog を Auto に設定しデフォッグ強

度レベルが 6～9 の間である場合は、霧が薄いときには画像は自動的に白黒に変化せず、

霧が濃くなるとカメラは自動的にデフォッグに切り換わります。 
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2. デフォグ機能を有効にし、シーンのレベルを選択します。レベル 9 では最大のデフォグ効果が

得られ、レベル 1 では最小となります。 

  

デフォグオフ デフォグオン 

 

3. デフォルトに復元するには Default をクリックします。 

照明タイプ 

 
ヒント！ 

この機能はモデルによって異なることがあります。詳細については、実際のモデルをご覧ください。  

 

1. [Setup] > [Image] > [Image] とクリックし、Smart Illumination をクリックします。 

 

2. Lighting Type ドロップダウンリストからオプションを選択します。 

3. デフォルトに復元するには Default をクリックします。 

絞りとレンズモードの設定 

 
ヒント！ 

 この機能は、特定のネットワークボックスカメラのタイプでのみサポートされます。詳細

については、実際のモデルをご覧ください。 

 P-Iris コントロールモードのレンズを使用し、絞りコントロールケーブルをカメラの Z/F ポ

ートに接続します。 

 Lens Mode が P-IRIS に設定に設定されている場合にのみ、絞りを設定することができます。 

 

1. [Setup] > [Image] > [Image] とクリックし、Advanced をクリックします。 

 

2. 必要に応じて設定を変更します。次の表に、主なパラメータが説明されています。 

パラメータ 説明 

レンズモード 
 Z/F：フォーカスとズームを変更します。 

 P-Iris：この値を変更します。 
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パラメータ 説明 

開口コントロ

ール 

絞りを自動または手動で調整します。 

注意：  

Lens Mode が P-Iris に設定されている場合にのみ、このパラメータを設定することがで

きます。 

F 値 開口を手動で変更します。 

 

3. デフォルトに復元するには Default をクリックします。 

OSD 設定 

オンスクリーンディスプレイ（OSD）とは、時刻などのカスタマイズされたコンテンツを含む、ビ

デオ画像に表示される文字のことです。 

 
ヒント！ 

この機能はモデルによって異なることがあります。詳細については、実際のウェブインターフェース

をご覧ください。 

 

1. [Setup] > [Image] > [OSD] とクリックします。 

 

一部モデルの OSD インターフェースは次のように表示されます。 
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2. OSDの位置とコンテンツを選択します。 

 位置：Live View エリアで希望のボックスをクリックします。カーソルの形が変化したら、ボタ

ンを押し続けて、ボックスを希望の位置に移動させます。正確な位置に配置するには、 

Overlay Area で X座標と Y 座標を使用します。 

 オーバーレイ OSD コンテンツ：ドロップダウンリストに Time、Preset、Serial Info が表示され

ます。Custom を選択して、希望のコンテンツを入力します。 

 位置と OSD コンテンツを設定すると、Status 列に の記号が表示されます。これは OSD の設

定が成功したことを示しています。各エリアに複数行のコンテンツを設定することができます。

表示の順番は と で調整できます。 

3. 設定を完了すると、設定が成功したことを示すメッセージが表示されます。 

プレビューウィンドウを右クリックして、全画面表示または希望のアスペクト比で表示することが

できます。プレビューウィンドウをダブルクリックすると、全画面表示をオンまたはオフにするこ

とができます。 

1 つのエリアで OSD をキャンセルするには、Overlay OSD Content 列で OSD コンテンツをクリアす

るか、Position 列で None を選択します。 

下に時間 OSD の一例が挙げてあります。 
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プライバシーマスク 

ATM マシンのキーボードなど、カメラの画像内の一部をマスクして、プライバシーを保護しなけ

ればならない場合があります。PTZ の位置やズームが変化すると、それに伴ってプライバシーマス

クが再調整されエリアが常時保護されます。 

 
ヒント！ 

 この機能はモデルによって異なることがあります。詳細については、実際のウェブインターフェ

ースをご覧ください。  

 一部のカメラモデルでは、最高 24 個所のプライバシーマスクがサポートされます。ただし、 

1 枚の画像では 8 個所のプライバシーマスクまでしか表示されません。 

 

1. [Setup] > [Image] > [Privacy Mask] とクリックします。 

 

一部のカメラのモデルでは、このページは次のように表示されます。  

 

2.  をクリックするとプライバシーマスクが追加され、  をクリックするとプライバシーマス

クが削除されます。 

 希望の位置をマスクするには：Mask という文字が表示されているボックスをクリックすると、

マスクが起動します。カーソルの形が変化したら、希望の位置にボックスをドラッグします。 

 希望のエリアをマスクするには：マウスで、マスクしたいエリアにボックスを描きます。 
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プライバシーマスクが設定されると、マスクしたい部分がブロックされます。下にその一例が挙げ

てあります。 

3. マスクモードを設定します。必要に応じて、通常モードと不規則モードが選択できます。不規

則モードでは、PTZ カメラが回転すると、画像内のマスクされた対象物の形状に応じてプライ

バシーマスクが変化します。 

 

 
ヒント！ 

 マスクモードは一部のモデルのみで使用できます。 

 

音声とビデオの設定 

ビデオ設定 

カメラがサポートするビデオパラメータを設定して、BNC 出力の現状を表示させることができます。

利用できる場合、必要に応じて、サブストリームとサードストリームを有効にすることもできます。 

 

ヒント！ 

 この機能はモデルによって異なることがあります。サードストリームは、一部のカメラモデルで

のみサポートされます。お使いのカメラでこの機能がサポートされているか判断するには、ウェ

ブインターフェースをご覧ください。 

 サブストリームやサードストリームを有効にした後で、必要に応じてパラメータを変更すること

ができます。サブストリームやサードストリームのパラメータは、メインストリームのパラメー

タと同じ意味を持ちます。 
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1. [Setup] > [Video & Audio] > [Video] とクリックします。 

 

2. 必要に応じて設定を変更します。次の表に、主なパラメータが説明されています。 

パラメータ 説明 

ビデオ圧縮 

H.265、H.264、MJPEG の 3 つのオプションがあります。 

注意：  

 ビデオ圧縮が H.265 または H.264 に設定されている場合、画質は設定できません。

MJPEG に設定されている場合、1、3、5 の 3 つのフレームレートのみが使用できま

す。 ビットレート、Iフレーム間隔、スムージング、U コードは設定できません。 

 設定を H.264と H.265の間で変更すると、ビットレートはデフォルトに変化しま

す。H.265のデフォルトビットレートは H.264 の半分です。 

フレームレート 

画像エンコードのフレームレート。単位：FPS（1 秒間のフレーム数）。 

注意：  

画質を確保するため、フレームレートを、シャッタースピードの逆数よりも大きく

しないでください。 

ビットレートの

タイプ 

 CBR：固定ビットレートとは、カメラが一定のデータレートでデータを送信する

ことを意味します。 

 VBR: 可変ビットレートとは、画質に応じて、カメラが動的にビットレートを調整

することを意味します。 

画質 

Encoding Mode が VBR の場合、スライダーを動かして画質レベルを調整することが

できます。スライダーを Bit Rate の方向に動かすとビットレートが減少して、画質

が悪くなることがあります。スライダーを Quality の方向に動かすとビットレートが

増加して、画質が改善されます。 

I フレーム間隔 
Iフレームがエンコードされる間隔です。通常、Iフレーム間隔が短くなると、画質は

向上しますが、帯域幅の消費量が多くなります。 
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パラメータ 説明 

GOP 
MPEG ビデオエンコーディングの画像集合体です。このパラメータで、イントラフ

レーム（Iフレーム）とインターフレームの配列順序が指定されます。 

SVC 
SVC（スケーラブルビデオコーディング）で、再生画質を务化させることなくスト

レージを減らすことができます。 

U-コード 

 基本モード：実際のビットレートは設定されたビットレートの約 3/4 です。 

 詳細モード：実際のビットレートは設定されたビットレートの約 1/2 です。 

注意：  

 U コードが有効になっている場合、H.264 と H.265 のビデオ圧縮のみがサポート

されます。MJPEG はサポートされません。 

 U コードが有効になっている場合、キャプチャモードは 31 以上のフレームレー

トをサポートしません。 

スムージング 

スムージングの程度を設定します。Clear を選択すると、Smoothing が無効になりま

す。スライダーを Smooth の方向に動かすとスムージングレベルは増加しますが、

画質が悪くなります。 

注意：  

ネットワーク環境がよくない場合、スムージングを有効にすると、ビデオの動きが

滑らかになります。 

BNC 出力 BNC 出力は NTSC と PAL をサポートします。 

 

3. Save をクリックします。 

音声コンフィギュレーション 

音声コンフィギュレーションとは、カメラの音声エンコーディングパラメータの設定を意味します。 

 

ヒント！ 

この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧ください。 

 

1. [Setup] > [Video & Audio] > [Audio] とクリックします。 
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2. 必要に応じて設定を変更します。次の表に、主なパラメータが説明されています。 

パラメータ 説明 

音声入力 

Off を選択すると、音声データはエンコードされません。 

注意：  

音声が不要な場合は Off を選択するよう推奨されます。これによって、デバイスのパ

フォーマンスがある程度改善されます。 

ア ク セ ス モ 

ード 

現在、ライン/マイクのみです。 

注意：  

この機能は、2個の音声出力チャンネルのあるデバイスでは使用できません。 

音声圧縮 

G.711U、G.711A、ACC-LC の 3 つのオプションがあります。  

G.711U と G.711A は 8K サンプリングレートのみをサポートし、ACC-LC は 8K、16K、48K

の各サンプリングレートをサポートします。 

入力ゲイン サンプリング用音声信号の増幅度です。ゲインが大きいほど、増幅度が大きくなります。 

ノイズ抑制 画像内のノイズを削減します。ノイズ抑制を有効にするにはOnを選択します。 

チャンネル 

音声出力チャンネルです。音声出力を有効にするには Enable を選択します。 

注意：  

2 個のチャンネルは、一部のカメラモデルでのみサポートされます。 

 

3. Save をクリックします。 

スナップショット 

1. [Setup] > [Video & Audio] > [Snapshot] とクリックします。 

 



36 

2. On を選択し、解像度を最大に設定し、必要に応じてスケジュールを設定します。下表に一部

のパラメータが説明されています。 

パラメータ 説明 

スナップショット 

間隔 

2 枚のスナップショットの撮影間隔です。 Snapshot Interval を 1 に設定し、

Number of Snapshot を 2 に設定すると、カメラは 2 枚のスナップショットを撮影

します（最初のスナップショットを撮影した 1 秒後に次のスナップショットを

撮影します）。 

スナップショットの

枚数 
現在、1 枚、2 枚、3 枚のスナップショットが設定できます。 

スナップショットモ

ード 

スケジュール：スナップショットを撮影する時刻を設定する必要があります。

例：19：12：00。これは、19：12：00 にスナップショットが撮影されることを

意味します。 

リピート：間隔が設定できます（単位：秒）。たとえば、上の図に表示されて

いる設定では、60 秒経過しないと、別の 2 枚のスナップショットは撮影されま

せん。 

 

3. Save をクリックします。 

ROI 

関心領域（ROI）が有効になっていると、システムは、ビットレートが不十分な場合に、まず、 

ROIの画質を確保します。 

 

ヒント！ 

この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧くだ

さい。 

 

1. [Setup] > [Video & Audio] > [ROI] とクリックします。 

 

2.  をクリックし、画像中の希望の部分をカバーするようにマウスをドラッグします。削除す

るには、エリアを選択して  をクリックします。 



37 

メディアストリームコンフィギュレーション 

メディアストリーム 

カメラで設定されたメディアストリームを表示することができます。また、UDP または TCP プロト

コルに従って、カメラが、指定の IP アドレスとポート番号にコードストリームを送信するように設

定することもできます。設定を保存した後でカメラを再起動すると、その設定が有効になります。 

 

ヒント！ 

 この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧

ください。 

 実際のニーズやネットワークのパフォーマンスに基づいて、トランスポートプロトコルを

選択します。一般に、TCP は、UDP よりも画質が向上しますが、レイテンシーが大きくな

ります。 

 

1. [Setup] > [Video & Audio] > [Media Stream] とクリックします。 

 

2.  をクリックし、ストリームタイプを選択し、カメラから音声とビデオのストリームを受信

するデコーディングデバイスのユニキャストまたはマルチキャストのグループの IP アドレス

とポート番号を設定します。 

デバイスの再起動後に、以前に自動的に設定したメディアストリームに戻したい場合は、

Persistent で Yes を選択します。 

3. ストリームを削除するには をクリックします。 

4. Submit をクリックして操作を完了します。 

RTSP マルチキャストアドレス  

RTSP マルチキャストアドレスを設定すると、サードパーティプレイヤーが、RTP プロトコルを介し

て、カメラから、RTSP マルチキャストメディアストリームを請求することができます。 
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1. [Setup] > [Video & Audio] > [Media Stream] > [RTSP Multicast Address] とクリックします。 

 

カメラのモデルによっては、このページは次のように表示されます。 

 

2. マルチキャストアドレス（224.0.0.0～239.255.255.255）とポート番号（0～65535）を設定します。 

3. Save をクリックします。 
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インテリジェントアラームコンフィギュレーション 

インテリジェント監視を設定して、人数を数えたり、動体を監視することができます。インテリジ

ェント監視には、人数カウント、侵入検知、自動追跡などがあります。 

サポートされる機能は、カメラのモデルによって異なることがあります。 

スマート設定 

[Setup] > [Intelligent] > [Smart Settings] とクリックします。 

 

カメラのモデルによっては、このページは次のように表示されます。 
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クロスライン検知 

クロスライン検知は、ライブビデオの仮想ラインを横切る物体を検知し、そのようなイベントが検

知されるとアラームを発します。 

1. [Setup] > [Intelligent] > [Smart Settings] とクリックします。Cross Line を選択し、  をクリック

します。 

 

2. Cross Line Detection を選択します。 

3. Detection Rule エリアで  をクリックして新しい検知エリアを追加します。検知エリアを削除

するには  をクリックします。 

4. 小さなプレビューウィンドウで希望の位置にラインをドラッグし、検知範囲を設定します。 

5. カメラにクロスライン検知アラームをレポートさせるか否かを決定する際の基準となる、カメ

ラの方向と感度を設定します。 

6. 必要に応じて、アラーム起動型動作と警戒スケジュールを設定します。詳しい手順については、

動体検知アラームの設定のアラーム起動型動作の説明をご覧ください。 

7. Save をクリックします。 
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侵入検知 

侵入検知は、ライブビデオで指定のエリアに侵入した物体を検知し、そのようなイベントが検知さ

れるとアラームを発します。 

1. [Setup] > [Intelligent] > [Smart Settings] とクリックします。Intrusion を選択して  をクリック

します。 

 

2. Intrusion Detection を選択します。 

3. Detection Rule エリアで  をクリックして新しい検知エリアを追加します。検知エリアを削除

するには  をクリックします。 

4. ボックスの境界線をドラッグして、希望の位置と範囲を設定します。 

5. カメラに侵入検知アラームをレポートさせるか否かを決定する際の基準となる、カメラの時間

しきい値と感度と割合を設定します。 

 時間しきい値：検知エリアに侵入者が侵入してからアラームがレポートされるまでの、最低滞

在時間です。 

 感度：検知感度です。値が大きいほど、検知感度が高くなります。 

 割合：指定の検知エリアのサイズに対する侵入者のサイズの割合の最低値です。侵入者のサイ

ズがこの値を上回ると、アラームがレポートされます。 

6. 必要に応じて、アラーム起動型動作と警戒スケジュールを設定します。詳しい手順については、

動体検知アラームの設定のアラーム起動型動作の説明をご覧ください。 

7. Save をクリックします。 
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移動物体 

指定エリアで物体が置き去りにされたことを検知して、アラームを発します。 

1. [Setup] > [Intelligent] > [Smart Settings] とクリックします。Object Moving を選択し、  をクリ

ックします。 

 

2. Enable Object Moving Detection を選択します。 

3. Detection Rule エリアで  をクリックして、検知エリアを追加します。検知するには  を

クリックします。 

4. ボックスをドラッグして位置と有効範囲を設定します。 

5. 侵入検知アラームをレポートさせるか否かを決定する際の基準となる、時間しきい値と感度を

設定します。 

 時間しきい値：指定エリアにおける物体の最低滞留時間です。この値を上回るとアラームがト

リガーされます。 

 感度：数値が大きいほど、感度が高くなります。指定エリアで、物体が検知される時間が指定

の時間を上回ると、アラームがレポートされます。 

6. 必要に応じて、アラーム起動型動作と警戒スケジュールを設定します。詳しい手順については、

動体検知アラームの設定のアラーム起動型動作の説明をご覧ください。 

7. Save をクリックします。 
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置き忘れ物 

指定エリアで物体が置き去りにされたことを検知して、アラームを発します。 

1. [Setup] > [Intelligent] > [Smart Settings] とクリックします。Object Left を選択し、  をクリッ

クします。 

 

2. Enable Object Left Detection を選択します。 

3. Detection Rule エリアで  をクリックして、検知エリアを追加します。検知するには  を

クリックします。 

4. ボックスをドラッグして位置と有効範囲を設定します。 

5. 侵入検知アラームをレポートさせるか否かを決定する際の基準となる、時間しきい値と感度を

設定します。 

 時間しきい値：指定エリアにおける物体の最低滞留時間です。この値を上回るとアラームがト

リガーされます。 

 感度：数値が大きいほど、感度が高くなります。指定エリアで、物体が検知される時間が指定

の時間を上回ると、アラームがレポートされます。 

6. 必要に応じて、アラーム起動型動作と警戒スケジュールを設定します。詳しい手順については、

動体検知アラームの設定のアラーム起動型動作の説明をご覧ください。 

7. Save をクリックします。 
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顔検知 

顔検知は、ライブビデオ内で人の顔を検知します。 

1. [Setup] > [Intelligent] > [Smart Settings] とクリックします。Face を選択し、  をクリックします。 

 

2. 境界線をドラッグして、希望の位置と範囲を設定します。 

3. 実際のニーズに応じて、検知パラメータを設定します。 

4. 必要に応じて、アラーム起動型動作と警戒スケジュールを設定します。詳しい手順については、

動体検知アラームの設定のアラーム起動型動作の説明をご覧ください。 

5. Save をクリックします。 

6. Start Intelligent Analysis をクリックします。 

人数カウント 

 

ヒント！ 

 この機能は、一部のカメラモデルでのみサポートされます。 

 サポートされるアラームのトリガーと警戒スケジュールは、カメラのモデルによって異な

ることがあります。詳細については、実際のウェブインターフェースをご覧ください。 

 



45 

1. [Setup] > [Intelligent] > [Smart Settings] とクリックします。People Counting を選択し、  をク

リックします。 

 

2. Enable Passenger Flow Detection を選択します。検知モードを選択し、レポート間隔と感度を設

定します。 

3. Draw Detection Area をクリックし、左側のプレビューウィンドウに検知エリア（正方形など）

を描きます。 

4. Draw Entrance Direction をクリックし、左側のプレビューウィンドウに方向を描きます。通常、

報告は垂直または傾斜方向です。 

5. Filter by Object Size で Max. Size と Min. Size を設定します。範囲内のサイズの物体のみがカウン

トされます。それ以外の物体はフィルタリングされカウントされません。最大幅または最大高

さは、最小幅または最小高さよりも大きくなければなりません。 

6. 必要に応じて、アラーム起動型動作と警戒スケジュールを設定します。詳しい手順については、

動体検知アラームの設定のアラーム起動型動作の説明をご覧ください。 

7. カウント結果をリセットするには、Clear Counting Result をクリックします。 

8. Saveをクリックします。 

自動追跡 

カメラは、ルールを満たす物体を自動的に追跡します。 

 

ヒント！ 

 この機能は、一部のカメラモデルでのみサポートされます。 

 サポートされるアラームのトリガーと警戒スケジュールは、カメラのモデルによって異な

ることがあります。詳細については、実際のウェブインターフェースをご覧ください。 
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1. [Setup] > [Intelligent] > [Smart Settings] とクリックします。Auto Tracking を選択し、  をクリ

ックします。 

 

2. 追跡タイムアウト（単位：秒）とズーム比を設定します。 

3. Save をクリックします。 

ヒートマップ 

ヒートマップでは、訪問者の通行パターンを、別々の色を使って表示します。赤などの暗い色は、

通行密度が高いことを示しています。 

1. [Setup] > [Intelligent] > [Smart Settings] とクリックします。Heat Map を選択し、  をクリック

します。 

 

2. Enable を選択します。 

热力图
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3. Background Update Rate を設定します。値が大きいほど、画像が頻繁に更新されるようになり

ます。 

4. Sensitivity を設定します。値が大きくなるほど、小さな物体が検知される可能性が高くなります。 

5. Min. Object Size を設定します。値が大きくなるほど、検知の際に無視される小物体の数が多く

なります。 

6. プラットフォームにおけるレポート統計の更新間隔を設定します。 

7. 必要に応じて、アラーム起動型動作と警戒スケジュールを設定します。詳しい手順については、

動体検知アラームの設定のアラーム起動型動作の説明をご覧ください。 

8. Save をクリックします。 

デフォーカス検知 

 

ヒント！ 

 この機能は、一部のカメラモデルでのみサポートされます。 

 サポートされるアラームのトリガーと警戒スケジュールは、カメラのモデルによって異な

ることがあります。詳細については、実際のウェブインターフェースをご覧ください。 

 

デフォーカス検知を使用してカメラのデフォーカスが検知され、そのようなイベントが検知される

とアラームがレポートされます。 

1. [Setup] > [Intelligent] > [Smart Settings] とクリックします。Defocus を選択し、  をクリックし

ます。 

 

2. Defocus Detection を選択します。 

3. 必要に応じて、検知感度とアラーム起動型動作を設定します。詳しい手順については、動体検

知アラームの設定のアラーム起動型動作の説明をご覧ください。 

4. Save をクリックします。 

シーン変更検知 

 

ヒント！ 

 この機能は、一部のカメラモデルでのみサポートされます。 

 サポートされるアラームのトリガーと警戒スケジュールは、カメラのモデルによって異な

ることがあります。詳細については、実際のウェブインターフェースをご覧ください。 
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シーン変更検知を使用して、意図的なカメラの回転などの外部要因による監視環境の変化を検知し、

そのようなイベントが検知されるとアラームがレポートされます。 

1. [Setup] > [Intelligent] > [Smart Settings] とクリックします。Scene Change を選択し、  をクリ

ックします。 

 

2. Scene Change Detection を選択します。 

3. 検知感度を設定します。必要に応じて、アラーム起動型動作と警戒スケジュールを設定します。

詳しい手順については、動体検知アラームの設定のアラーム起動型動作の説明をご覧ください。 

4. Save をクリックします。 

高度な設定 

高度な設定には、スナップショットの明瞭性、検知モード、インテリジェント機能などがあります。 

写真パラメータ 

スナップショットの明瞭性を設定します。 

1. [Setup] > [Intelligent] > [Advanced Settings] とクリックします。Photo parameters タブをクリック

します。 

 

2. サムネイルの明瞭性を設定します。 

3. Save をクリックします。 

 

ヒント！ 

写真パラメータを設定する前に、顔検知を解除してください。 
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検知パラメータ 

 

ヒント！ 

 高度な設定は、一部のカメラモデルでのみサポートされます。詳細については、実際のウ

ェブインターフェースをご覧ください。 

 デフォルト検知モードは Normal Mode です。必要に応じて設定します。 

 

1. [Setup] > [Intelligent] > [Advanced Settings] とクリックします。Detection parametersタブをクリ

ックします。 

 

 

2. 検知モードを選択します。監視対象の環境で動体検知が繰り返されるたびにアラームが発生し

ないように、Filter Repeated Motion Mode を選択します。 

3. Save をクリックします。 

 

ボックス-ドームのリンケージ 

 

ヒント！ 

 この機能は、一部のカメラモデルでのみサポートされます。 

 サポートされるリンケージパラメータとリンケージモードと警戒スケジュールは、カメラ

のモデルによって異なることがあります。詳細については、実際のウェブインターフェー

スをご覧ください。 

1. [Setup] > [Intelligent] > [Smart Settings] とクリックします。Box-Dome Linkage を選択し、  を

クリックして、Linkage Parameter タブを選択します。 

 

カメラのモデルによっては、このページは次のように表示されます。 
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2. Enable Box-Dome Linkage を選択します。 

3. マスターまたはスレーブ IP アドレス、HTTP ポート、ズーム係数を設定します。  

4. Save をクリックします。 

5. Mark Linkage タブを選択します。 

 

6. Manual Mark をクリックすると、次のページが表示されます。ボタンの意味：  
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前/次：現在のシーンでマーキング操作を終了すると、マーキングシーンが変化します。 

エンドマーキング：保存せずにマーキング操作を終了します。 

追加/削除：マーキングポイントを追加または削除します。 

すべてクリア：このページのマーキングポイントをすべて削除します。 

7. 1 枚のマーキングページでマーキングを行なうには次のステップを実行します。Add をクリッ

クし、左側のマスターカメラ画像をクリックします。クリックした個所に小さな白いフレーム

が現われ、そのエリアが自動的に拡大されます（下に例を示します）。OK をクリックして現

在のマーキングポイントを確定するか、右クリックしてオリジナル画像に戻ります。 

 

8. マーキングポイントのある位置にスレーブカメラを向けます。スレーブカメラの拡大率を最大

に設定し、スレーブカメラの画像中心の十字を、マスターカメラ画像のマーキングポイント 

（白い小さなフレーム）と一致させます。OK と Orient をクリックして、マーキングポイント

をリンクさせます。Cancel をクリックすると、リンクされたマーキングポイントがキャンセル

されます。 



52 

9. マスターカメラ画像で新しい位置をクリックして、最後の手順を繰り返します。ニーズによっ

て異なりますが、5 個ないし 12 個のマーキングが必要です。Finish と Next をクリックすると、

次のシーンに移動します。 

10. マーキング設定がすべて終了したら、Apply をクリックします。マルチセンサーカメラの場合、

4 か所のシーンでマーキング設定を行なった後でボタンをクリックします。 

 

 

共通アラームコンフィギュレーション 

アラームと、それによって起動する動作が時間内に処理できるように、アラームレポートのスケジ

ュールを設定して、他のデバイスによって起動できる動作を設定することができます。 

アラームレポートのスケジュールは、動体検知アラーム、アラーム入力、アラーム出力、タンパー

検知アラーム、音声検知アラームに設定できます。サポートされるアラームは、デバイスモデルに

よって異なることがあります。お使いのカメラでサポートされるアラームタイプについては、ウェ

ブインターフェースをご覧ください。 

動体検知アラームの設定 

動体検知は、指定の期間内に、指定の長方形エリア中の動体を検知します。動体を検知した際に動

体検知アラームをレポートするかどうかを決定するために、検知エリア、検知感度、物体のサイズ、

カメラの履歴を設定する必要があります。 

 

ヒント！ 

 この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧ください。 

 アラーム起動型動作はモデルによって異なることがあります。詳細については、実際のウェブイ

ンターフェースをご覧ください。 
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エリア検知 

1. [Setup] > [Events] > [Common Alarm] > [Motion Detection] とクリックします。Detection Mode を

Area に設定します。 

 

2. Detection Area エリアで  をクリックして、新しい検知エリアを追加します。検知エリアを削

除するには  をクリックします。 

3. マウスをクリックしてドラッグし、検知エリアを設定します。 

4. 動体を検知した際に動体検知アラームをレポートするかどうかを決定するために、検知感度、

物体のサイズ、カメラの履歴を設定します。 

 スライダーを右に動かすと、検知感度が増加します。検知エリア内の動体の動きが設定した物

体のサイズを上回ると、カメラはアラームをレポートします。 

 物体のサイズは、検知エリア全体のサイズに対する物体のサイズの割合の最低値です。物体のサ

イズがこの値を上回ると、アラームがレポートされます。すなわち、小さな物体の動きを検知す

るには、実際の動体エリアに対して、小さなボックス（検知エリア）を描く必要があります。 

 動体検知の結果はリアルタイムで表示されます。赤い線は、動体検知アラームの発生した時点を

示しています。動きが大きいほど、線が長くなります。動きが頻繁なほど、線が太くなります。 

 

 

5. アラームパラメータを設定します。 

 アラームの抑制：アラームがトリガーされた後で、設定された時間内に同じアラームがトリガ

ーされてもレポートされません。 

 アラームのクリア：アラームが起動した後で、 

a. 設定された時間内に同じアラームがトリガーされなかった場合、アラームはクリアされ、

同じアラームを再度レポートすることができます。 
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b. 設定された時間内に同じアラームがトリガーされた場合、抑制アラーム時間が経過するまで

アラームはクリアされません。その後、同じアラームを再度レポートすることができます。 

6. 動体検知アラーム起動型動作とプランを設定します。 

 

下表に、主なアラーム起動型動作とプランの設定方法が説明されています。 

項目 説明 

アラーム出力1 

チェックボックスを選択します。この設定は、動体検知アラームにリンクされたアラー

ム出力インターフェースです。 

注意：  

アラームがレポートされると、カメラは、サードパーティデバイスによる動作が起動す

るように、アラーム出力をトリガーします。 

プリセットに

進む 

このチェックボックスを選択し、動体検知アラームにリンクされるプリセットを設定し

ます。 

注意：  

 プリセットが設定されたことを確認してください。さもないと、このパラメータを設

定することはできません。プリセットの設定方法については、プリセットの設定を参

照してください。 

 アラームがレポートされると、PTZ カメラは自動的にプリセットに進み、適切なシー

ンでビデオを取得します。 

FTP へアップ

ロード 

Upload to FTP を選択した場合、アラームがトリガーされると、カメラは、自動的に、指

定の FTP サーバにスナップショットをアップロードします。 

注意：  

この機能を使用する前に、FTP とスナップショットの設定を完了しておいてください。 

録画 

Recording が選択されている場合、アラームがトリガーされると、カメラは自動的にビ

デオを録画します。 

注意：  

まず、Storage ページでを Post-Record(s) 設定してください。Post-Record(s) は、アラーム

終了後に録画が継続される時間を指定します。 

センターをア

ラームする 

Alarm the Center を選択した場合、アラームがトリガーされると、カメラは、中央サーバ

にアラーム情報を送信します。 

注意：  

まず、Server ページで設定を完了してください。 

追跡をトリ 

ガー 

Trigger Tracking を選択した場合、アラームがトリガーされると、カメラは、自動追跡を

開始します。 

注意：  

この機能は、一部のカメラモデルでのみサポートされます。 

まず、Smart Settings ページで自動追跡を設定してください。 

メールをトリ

ガー 

Trigger E-mail を選択した場合、アラームがトリガーされると、カメラは、自動的に、指

定のメールアドレスにスナップショットを送信します。 

注意：  

この機能を使用する前に、Eメールの設定を完了しておきます。 
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プランの有 

効化 

このチェックボックスを選択して、動体検知動作の開始時刻と終了時刻を設定します。

直接マウスをドラッグしてプランを描き、Edit をクリックして表中の時刻を編集するこ

とができます。時間は重複できません。カメラは、指定時間内にのみアラームをレポー

トします。 

月曜から日曜までが選択でき、各曜日に 4 つまで時間を設定できます。 

 

 

マウスをドラッグしてプランを描きます。  表中の時間を編集します。 

注意：  

マウスによるプランの描画は、IE バージョン 8.0 以降でのみサポートされます。1 日の

プランを設定した後で、Copy と Paste をクリックすると、同じ設定を別の日に適用する

ことができます。 

 

7. Save をクリックします。 

グリッド検知 

1. [Setup] > [Events] > [Motion Detection] とクリックします。Detection Mode を Grid に設定します。 

 

2. グリッド上で不規則な検知エリアを設定することができます。 

3. 動体検知アラームをレポートするかどうかを決定するために、カメラの検知感度を設定します

（アラームは、互換性のある NVR に表示されます）。 

4. アラームパラメータを設定します。 

 アラームの抑制：アラームがトリガーされた後で、設定された時間内に同じアラームがトリガ

ーされてもレポートされません。 

 アラームのクリア：アラームが起動した後で、 

a. 設定された時間内に同じアラームがトリガーされなかった場合、アラームはクリアされ、

同じアラームを再度レポートすることができます。 
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b. 設定された時間内に同じアラームがトリガーされた場合、抑制アラーム時間が経過するまで

アラームはクリアされません。その後、同じアラームを再度レポートすることができます。 

5. 動体検知アラーム起動型動作とプランを設定します。詳しい手順については、動体検知アラー

ムの設定のエリア検知のアラーム起動型動作の説明をご覧ください。 

6. Save をクリックします。 

タンパーアラームの設定 

レンズが指定の時間の間ふさがれるとカメラがタンパーアラームをレポートするように、タンパー

アラームを設定します。 

 

ヒント！ 

 この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧くだ

さい。 

 アラーム起動型動作はモデルによって異なることがあります。詳細については、実際のウェブイ

ンターフェースをご覧ください。 

 

1. [Setup] > [Events] > [Common Alarm] > [Tampering Alarm] とクリックします。 

 

2. Tampering Alarm で On を選択します。 

3. カメラにタンパーアラームをレポートさせるか否かを決定する際の基準となる、カメラの検知

感度と時間を設定します。 

感度は、高レベル、中レベル、低レベルの 3 つに分割されています。感度を高レベルに設定

した場合、カメラは、中レベルよりも遠い場所までレンズのブロックを検知することができ

ます。指定の時間、レンズがふさがれると、カメラはタンパーアラームをレポートします。 

タンパーアラームは画面全体で有効です。タンパーアラームを無効にするには、 

Tampering Alarm チェックボックスからマークを外します。 

4. タンパーアラーム起動型動作とプランを設定します。詳しい手順については、動体検知アラー

ムの設定のアラーム起動型動作の説明をご覧ください。 

5. Save をクリックします。 
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音声検知アラームの設定 

カメラは、音声入力信号の異常を検知することができます。音量の上昇度や下降度が設定限界を超

えたり、入力音量がしきい値に達すると、カメラはアラームをレポートし、設定された動作をトリ

ガーします。音声入力デバイスがカメラに正しく接続され、アラーム入力の指定で音声入力がオン

になっていることを確認してください。 

 

ヒント！ 

 この機能は一部のモデルではサポートされません。詳細については、実際のウェブインターフェ

ースをご覧ください。 

 アラーム起動型動作はモデルによって異なることがあります。詳細については、実際のウェブイ

ンターフェースをご覧ください。 

 

1. [Setup] > [Events] > [Common Alarm] > [Audio Detection] とクリックします。 

 

2. Audio Detection で Enable を選択し、検知タイプを選択し、音量差またはしきい値を設定します。

音声検知を無効にするには、Enable チェックボックスからマークを外します。 

次の表に、主なパラメータが説明されています。 

パラメータ 説明 

検知のタイプ 

 急激な上昇: 音量の上昇度が音量差を上回ると、アラームがレポートされます。 

 急激な下降：音量の下降度が音量差を上回ると、アラームがレポートされます。 

 急激な変化: 音量の上昇度または下降度が音量差を上回ると、アラームがレポート

されます。 

 しきい値: 音量がしきい値を上回ると、アラームがレポートされます。 

音量差 

 しきい値: しきい値として音量が設定されると、しきい値を超えたときにアラーム

がレポートされます。 

 音量差：2つの音量の差。音量の上昇度または下降度が音量差を上回ると、アラー

ムがレポートされます。 

注意：  

 音声検知エリアのスケールを使用して、音量が測定されます。 

 音声検知の結果はリアルタイムで表示されます。赤い部分は、音声検知アラームが

レポートされた部分を示しています。 
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パラメータ 説明 

 

 

 

3. 必要に応じて、アラーム起動型動作と警戒スケジュールを設定します。詳しい手順については、

動体検知アラームの設定のアラーム起動型動作の説明をご覧ください。 

4. Save をクリックします。 

アラーム入力の指定 

カメラは、サードパーティデバイスからアラーム情報を受信することができます。この機能を使用

するには、まず、アラーム入力に、ポート、アラーム名、アラームタイプ（ノーマルオープンかノ

ーマルクローズか）、アラームレポート時間の各情報を設定する必要があります。 

 

ヒント！  

 この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧ください。 

 アラーム起動型動作はモデルによって異なることがあります。詳細については、実際のウェブイ

ンターフェースをご覧ください。 

 

ScaleVolume

Difference
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1. [Setup] > [Events] > [Common Alarm] > [Alarm Input] とクリックします。 

 

2. アラームを選択し、アラーム名を設定します。 

3. サードパーティアラーム入力デバイスのタイプに応じて、N.O. または N.C. を選択します。た

とえば、サードパーティアラーム入力デバイスがノーマルオープンの場合、ここで N.O. を選

択します。すると、カメラは、サードパーティアラーム入力デバイスからアラームを受信でき

ます。 

4. 入力アラーム起動型動作とプランを設定します。詳しい手順については、動体検知アラームの

設定のアラーム起動型動作の説明をご覧ください。 

5. Saveをクリックします。 

アラーム出力の設定 

アラーム出力がノーマルオープンまたはノーマルクローズに正しく設定されている場合、動体検知

アラーム（ブーリアン型アラーム）によってアラーム出力がトリガーされると、カメラはサードパ

ーティデバイスに、アラーム情報を出力することができます。アラーム出力の時間を設定すること

ができます。 

 

ヒント！ 

この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧くだ

さい。 
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1. [Setup] > [Events] > [Common Alarm] > [Alarm Output] とクリックします。  

 

2. アラームを選択し、アラーム名を設定します。 

3. 状態を N.O.（デフォルト設定）に設定し、アラーム時間を設定します。 

4. アラームライトなどのサードパーティアラームデバイスに適合するように、リレーモードを設

定します。お使いのサードパーティアラームデバイスに応じて、トリガーモードを選択してく

ださい。 

項目 説明 

モノステー

ブル 
アラーム出力は、パルスによってサードパーティアラームデバイスをトリガーします。 

バイステー

ブル 
アラーム出力は、高レベルまたは低レベルによってサードパーティアラームデバイスをトリガ

ーします。 

 

5. 入力アラーム起動型動作とプランを設定します。詳しい手順については、動体検知アラームの

設定のアラーム起動型動作の説明をご覧ください。 

6. Save をクリックします。 

 

注意！ 

デバイスの電源を入れる際には、カメラのコンポーネントを破損させないように、正しい順番に

入れてください。  

1. アラームタイプが Normally Open （デフォルト設定）に設定され、カメラとアラーム出力デ

バイスの電源が切ってあることを確認します。  

2. 接続が終了したら、まずカメラの電源を入れ、次にアラーム出力デバイスの電源を入れます。 
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メモリカードストレージ 

 
ヒント！ 

 一部のモデルではこの機能はサポートされません。またモデルによって機能が異なること

があります。詳細については、実際のモデルをご覧ください。 

 カメラがスタンドアロンモードで動作する場合は、エッジストレージが推奨されます。カ

メラが中央管理サーバで管理される場合、キャッシュポスト録画サービスに影響が出ない

ように、エッジストレージを停止する必要があります。 

 ポスト録画機能に対応するデバイスでは、Post-Record が表示されます。この機能に対応し

ないカメラでは、このパラメータは表示されません。 

 

エッジストレージの設定 

エッジストレージを使用して、メモリカードに、直接、ビデオデータとスナップショットが保存さ

れます。カメラがスタンドアロンモードで動作している場合は、エッジストレージが推奨されます。 

マニュアルストレージ 

マニュアルストレージが有効になっている場合は、カメラは繰り返しライブビデオを録画します。 

1. [Setup] > [Storage] > [Storage] とクリックします。 

 

2. エッジストレージを起動し、必要に応じて設定を変更します。次の表に、主なパラメータが説

明されています。 

パラメータ 説明 

ス ト レ ー ジ 

媒体 

ストレージリソースの種別です。 

注意：  

 メモリカードをフォーマットするには、まず、カードのストレージ機能を無効に

します。次に、Formatをクリックし、OK をクリックして操作を確定します。フォ

ーマットが完了すると、システムが再起動します。 

 総容量と空きスペースに関する情報が表示されます。 

データ上書き

ポリシー 

 上書き：メモリカードに空きスペースがない場合、既存のデータの上に新しいデ

ータが繰り返し上書きされます。 

 停止: メモリカードに空きスペースがない場合、メモリカードに新しいデータは保

存されません。 
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パラメータ 説明 

ポ ス ト レ コ 

ード 
アラーム起動型録画の場合、アラームが終了した後も、継続して録画されます。 

 

3. Save をクリックします。 

ストレージプラン 

スケジュール録画が有効になっている場合、カメラは、指定の時間、メモリカードにビデオを録画

します。 

1. [Setup] > [Storage] > [Storage] とクリックします。 

 

カメラのモデルによっては、このページは次のように表示されます。 
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2. Planned Storage を選択し、カメラがメモリカードにビデオを録画する時間を設定します。 

3. Save をクリックします。 

 
ヒント！  

 マニュアルストレージとスケジュール録画の両方が有効になっている場合、スケジュール

録画は有効になりません。 

 メモリカードで録画を検索するには、エッジストレージによるビデオ再生とダウンロード

をご覧ください。 

 

キャッシュポスト録画の設定 

中央管理されているカメラでは、中央管理サーバのバックアップストレージリソースとして、メモ

リカードを使用することができます。ネットワーク接続状態が不安定なために、カメラから中央ス

トレージデバイスへの保存が中断した場合、カメラは、自動的にキャッシュポスト録画を開始し、

メモリカードにビデオを保存します。 

録画バックアップが有効になっている場合、カメラとバックアップサーバとの間の通信が復帰した

ときに、カメラは、自動的に、メモリカードに保存されているビデオを、ファイルの形で、バック

アップサーバのストレージリソースに転送することができます。 

 
ヒント！ 

カメラでキャッシュポスト録画を設定する前に、以下の各項目を確認してください：  

 メモリカードがカメラに正しくインストールされている。 

 中央サーバにバックアップリソースが追加されている。 

 カメラにバックアップリソースが割り当てられている。 

 ポスト録画機能に対応するデバイスでは、Post-Record が表示されます。この機能に対応し

ないカメラでは、このパラメータは表示されません。 
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エッジストレージの無効化 

1. [Setup] > [Storage] > [Storage] とクリックします。 

 

2. Storage Policy を Off に設定します。カメラがこの機能をサポートする場合ポスト録画が表示さ

れるので、Post-Record(s) を設定します。 

3. Save をクリックします。 

システムメンテナンス 

 
ヒント！  

この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧くだ

さい。 

 

セキュリティ 

ユーザ管理 

システムユーザには次の 2 種類があります：  

 管理者：本書では「admin」と称します。管理者のデフォルト名は admin で、これを変更する

ことはできません。Admin には全権限が与えられ、全ユーザと全デバイスを管理することがで

きます。1 台のシステムには 1 人の admin ユーザのみが許可されます。 

 共通ユーザ：本書では「ユーザ」と称します。ユーザは、ライブビデオと録画済みビデオを再

生する権限しかありません。1 台のシステムには 32 人までの共通ユーザが許可されます。 

ユーザ管理インターフェースでユーザを追加することができます（[Setup] > [Security] > [User] で）。 

ユーザが追加できたら、新しいパスワードでパスワードを変更したり、ユーザ名をクリアしてユー

ザを削除することができます。 

 
ヒント！ 

 admin のみがパスワードを変更できます。ユーザのログイン中にユーザ名またはパスワー

ドを変更すると、そのユーザは強制的にログアウトされます。この場合、そのユーザは新

しいユーザ名とパスワードを使用しなければログインできません。 

 admin のみがユーザを追加または削除できます。ログイン中のユーザを削除すると、その

ユーザは強制的にログアウトされます。削除されたユーザはログインできません。 

 



65 

セキュアデータ転送の設定 

セキュリティを確保するため、データ転送用のセキュアチャンネルを設定します。 

 
ヒント！  

この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご

覧ください。 

 

1. [Setup] > [Network] > [Port] とクリックします。 

 

2. HTTPS Port テキストボックスにポート番号を入力します。 

3. Save をクリックします。 

4. [Setup] > [Security] > [Network Security] > [HTTPS] とクリックします。 

 

5. HTTPS で On を選択します。必要に応じてカスタム SSL証明書をインポートすることができます。 

6. Save をクリックします。 

次回ログインする際に、https: //IP: HTTPS port number フォーマット（例：https: //192.168.1.13: 443 に

アドレスを入力してセキュアチャンネルモードに進みます。デフォルト HTTPS ポートを使用する

場合は、https: //IP を入力します。 

認証  

RTSP（リアルタイムストリーミングプロトコル）はアプリケーションレイヤープロトコルです。音

声とビデオを送信して制御するには、ウェブインターフェースで RTSP 認証を設定します。 

1. [Setup] > [Security] > [Network Security] > [Authentication] とクリックします。 

 

2. 認証モードを選択して Save をクリックします。 

ベンダー情報の非表示 

ウェブインターフェースでネットワークカメラのベンダー情報を非表示にするよう設定できます。 

1. [Setup] > [Security] > [Registration Info] とクリックします。 

 

2. Registration Info で On を選択します。 

3. Save をクリックします。 

APR保護 

この機能は、ARP 攻撃からカメラを保護します。ゲートウェイと MAC アドレスを適切に設定しな

ければ、PC は別のネットワークからカメラにアクセスできません。MAC が間違って設定された場

合、同じ LAN 上の PC しかアクセスできません。 
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1. [Setup] > [Security] > [Network Security] > [ARP Protection] とクリックします。 

 

2. チェックボックスを選択して ARP バインディング機能を有効にし、ゲートウェイの MAC アド

レスを設定します。 

3. Save をクリックします。 

IPアドレスフィルタリング 

IPアドレスフィルタリングを使用して、指定の IP アドレスからのアクセスを許可または禁止します。 

 
ヒント！  

この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧くだ

さい。 

 

1. [Setup] > [Security] > [Network Security] > [IP Address Filtering] とクリックします。 

 

2. On を選択して IP アドレスフィルタリングを有効にします。 

3. フィルタリングモードを選択し、IP アドレスを追加します。 

4. Save をクリックします。 

 
ヒント！ 

 Filtering Mode が Whitelist に設定されている場合、追加された IP アドレスのみがカメラに

アクセスできます。Filtering Mode が Deny Access に設定されている場合、追加された IP ア

ドレスのみがカメラにアクセスできなくなります。 

 IP アドレスは 32 個まで追加できます。各 IPアドレスは 1 回しか追加できません。 

 各 IP アドレスの最初のバイトは 1～223でなければならず、第 4 バイトは 0 にできません。

た と え ば 、 次 の IP ア ド レ ス は 不 正 で す の で 追 加 で き ま せ ん ： 

0.0.0.0, 127.0.0.1, 255.255.255.255, 224.0.0.1。 
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アクセスポリシー 

 
ヒント！ 

フレンドリーなパスワードを有効にしても使用法は変わりません。これをオフにして弱いパスワ

ードでログインすると、ページがポップアップ表示され、パスワードを変更するよう指示されま

す。このページには Cancel や Close のボタンはありません。デフォルトパスワードは弱いパスワ

ードと見なされます。 

 

1. [Setup] > [Security] > [Network Security] > [Access Policy] とクリックします。 

 

2. On を選択し、フレンドリーなパスワードと MAC 認証を有効にします。 

3. Save をクリックします。 

デジタルウォーターマーク 

不正に削除または変更できないように、デジタルウォーターマークを使用してビデオのカスタム情

報を暗号化します。 

 
ヒント！ 

この機能は、一部のカメラモデルでのみサポートされます。 

 

1. [Setup] > [Security] > [Watermark] とクリックします。 

 

2. On を選択し、デジタルウォーターマークを有効にし、デジタルウォーターマークのコンテン

ツを入力します。 

3. Save をクリックします。 

システム時刻の設定 

以下の方法を使用して、デバイスのシステム時刻を調整します。 

手動によるシステム時刻の設定と同期 

1. [Setup] > [Common] > [Time] とクリックし、Time タブをクリックします。 

 

2. 同期モードを選択します。 

3. 正しいタイムゾーンとシステム時刻を設定します。Sync with Computer Time をクリックして、

カメラの時刻設定を PC の時刻と同期させることもできます。 

4. Save をクリックします。 
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NTP サーバとの同期 

1. [Setup] > [Common] > [Time] とクリックし、Time タブをクリックします。 

 

2. Sync Mode を Sync with NTP Server に設定し、NTP サーバの IP アドレスとポート番号および更新

間隔を設定します。 

3. Save をクリックします。すると、カメラは、定期的に、NTP サーバと時刻を同期します。 

夏時間の設定 

1. [Setup] > [Common] > [Time] とクリックし、DST タブをクリックします。 

 

2. DST で On を選択し、開始時刻、終了時刻、夏時間と冬時間との差を設定します。 

3. Save をクリックします。 

サーバの設定 

インテリジェントサーバー 

中央サーバで超高感度カメラが管理される場合、インテリジェントサーバを設定する必要があり

ます。 

 
ヒント！ 

 インテリジェントサーバは、一部のカメラモデルでのみサポートされます。 

 顔スナップショットを使用するには、スナップショットのアップロード先の TMS サーバを

設定する必要があります。 

 

1. [Setup] > [Common] > [Server] とクリックし、Intelligent Server タブをクリックします。 

 

2. TMS サーバの IP アドレスを設定して、他の設定を完了します。 

3. Save をクリックします。 

Server IP

Server Port

Device No.
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シリアルポートモードの設定 

サードパーティデバイスとのデータ交換には RS485 シリアルポートが使用されます。カメラのシリ

アルポートの設定は、接続されるサードパーティデバイスの設定と一致する必要があります。 

 
ヒント！ 

この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧くだ

さい。 

 

PTZ コントロール 

サードパーティデバイスを通じて PTZ カメラを制御するには、Port Mode を PTZ Control に設定する

必要があります。  

RS485 ポートを通じて PELCO-D に準拠する PTZコントロールコマンドを送信すると、PTZ コントロ

ールパネルを使用せずに PTZカメラを制御することができます。 

1. [Setup] > [System] > [Ports & Devices] とクリックし、Serial Port タブをクリックします。 

 

2. Port Mode ドロップダウンリストから PTZ Control を選択します。次の表に、主なパラメータが

説明されています。 

パラメータ 説明 

PTZプロトコル 

チャンネルがサポートするPTZプロトコルを設定します。 

注意：  

 Port Mode が PTZ Control に設定されている場合にのみ、このパラメータを設定する

ことができます。  

 PTZ Protocol が INTERNAL-PTZ に設定されていると、シリアルポートを使用せずに、

外部 PTZに接続することができます（シリアルポートパラメータはグレーアウトさ

れます）。この場合、レンズにカメラのズームインターフェースとフォーカスイン

ターフェースを接続するだけで済みます。すると、内部 PTZ と同様に PTZ が操作で

きます。 
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パラメータ 説明 

PTZモード 

 内蔵 PTZ 優先：このオプションを選択すると、カメラはまず、外部 PTZ を使用せず

に、カメラ本体だけで PTZ を制御しようとします（ズームやフォーカスなど）。カ

メラ本体だけで制御できない操作は、外部 PTZ を通じて実行されます。 

 外部 PTZ 優先：カメラはまず、シリアルポートから接続された PTZ を通じて、PTZ を

制御しようとします。 

注意：  

 Port Mode が PTZ Control に設定されている場合にのみ、このパラメータを設定する

ことができます。 

 INTERNAL-PTZ が選択されている場合、このパラメータは、常に Built-in PTZ Priority 

に設定されるので、シリアルポートを通じてカメラを外部 PTZ に接続する必要はあ

りません。カメラは外部 PTZ に接続されていても、外部 PTZ を介した操作は無効に

なります。 

 必要に応じてこのパラメータを設定します。PTZ コントロール関連のインターフェ

ースを正しく接続してください。 

ア ド レ ス コ 

ード 

PTZ のアドレスコードを設定します。 

注意：  

Port Mode が PTZ Control に設定され、PTZ Protocol が INTERNAL-PTZ に設定されていな

い場合にのみ、このパラメータを設定することができます。 

 

3. Save をクリックします。 

透過チャンネル 

サードパーティデバイスとの透過データ伝送には、RS485 シリアルポートが使用されます。透過チ

ャンネルは、主に、2 台のデバイス間の透過データ伝送に使用されます。 

 
ヒント！  

 この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧

ください。 

 カメラで Port Mode を Trans-Channel に設定してください。 

 

1. [Setup] > [System] > [Ports & Devices] とクリックし、Serial Port タブをクリックします。 

 

2. Port Mode ドロップダウンリストから Trans-Channel を選択します。 
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3. Trans-Channel で Enable を選択します。 

4. 転送先の IP アドレスとポート番号（透過チャンネルの接続先の IP アドレスとポート番号）を

入力します。 

5. Save をクリックします。 

OSD 

OSD にサードパーティデバイスからの情報を表示するには、ポートモードとして OSD を選択する

必要があります。 

カメラは RS485 シリアルポートを通じてサードパーティデバイスから情報を受信し、受信した情報

を翻訳し、OSD に表示します。 

 
ヒント！ 

カメラが、サードパーティデバイスから受信した情報を正しく翻訳できるようにするには、シリ

アルポートを通じてサードパーティデバイスから送信される情報が、当社で指定したデータフォ

ーマットに準拠している必要があります。詳細については販売店にお問い合わせください。 

 

1. [Setup] > [System] > [Ports & Devices] とクリックし、Serial Port タブをクリックします。 

 

2. Port Mode ドロップダウンリストから OSD を選択します。（OSD データがプラットフォームに

アップロードされるように） Enable OSD Report を選択します。 

3. Save をクリックします。 

ONVIF 透過チャンネル 

カメラの RS485 ポートとサードパーティデバイスとの間の透過チャンネル（ONVIF）を通じてデー

タを転送します。 

1. [Setup] > [System] > [Ports & Devices] とクリックし、Serial Port タブをクリックします。 
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2. Port Mode を Select Trans-Channel via ONVIF に設定します。 

3. Save をクリックします。 

ワイパーコントロール 

ワイパーパラメータを設定すると、ワイパーを制御することができます。 

 
ヒント！  

この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧くだ

さい。 

 

1. [Setup] > [System] > [Ports & Devices] とクリックし、External Device タブをクリックします。 

 

2. ワイパーのコントロールモードを選択します。次の表に、主なパラメータが説明されています。 

パラメータ 説明 

シ リ ア ル ポ 

ート 

ワイパーは PELCO-D の指示で制御されるので、PTZ プロトコルを PELCO-D に設定する

必要があります。詳細については PTZ コントロールをご覧ください。 

ア ラ ー ム 入 

出力 
アラーム入出力を使用して回路を開閉し、ワイパーを制御します。 

 

デバイス状態の表示 

現在のカメラの状態を表示することができます。 

1. [Setup] > [Common] > [Basic Info] とクリックします。 

 

2. Refresh をクリックすると状態に関する最新情報が表示されます。 

3. デバイス情報が表示されます。 

IPC

IPC

A

V1.0

2102335CC3531740100232

192.168.1.13/255.255.255.0/192.168.1.1

48:ea:63:4d:56:88

2018/1/25 19:16:27

0 Day(s) 0 Hour(s) 0 Minute(s)

Offline
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ヒント！  

基本情報ページに、デバイスモデル、ファームウェアバージョン、インテリジェントサーバーの

状態などを表示させることができます。 

 

写真ストレージの状態 

現在の写真ストレージの状態が表示されます。ストレージポリシーの全文はメモリカードストレー

ジをご覧ください。 

 
ヒント！  

ストレージ機能を有するモデルのみがこの機能をサポートします。詳細については、実際のモデ

ルをご覧ください。 

 

1. Photoをクリックします。 

 

2. Refreshをクリックすると、ストレージの状態が更新されます。 

3. Image List エリアで、写真をエクスポートまたは削除できます。 
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デバイスのアップグレード 

中央管理サーバで管理されるデバイスを一括モードでアップグレードしたい場合、中央サーバでア

ップグレード操作を実行するよう推奨されます。詳しい手順については、中央管理サーバのユーザ

マニュアルをご覧ください。 

1. [Setup] > [System] > [Maintenance] とクリックします。 

 

2. Software Upgrade で Browse をクリックし、適切なアップグレードファイルを選択します。 

3. Upgrade をクリックし確定すると、アップグレードが始まります。アップグレードが完了する

と、カメラは自動的に再起動します。一部のデバイスでは、起動プログラムのアップグレード

がサポートされます。アップグレードを行なうには Upgrade Boot Program を選択します。 

4. Detect をクリックすると、クラウドアップグレードで新バージョンが利用できるかどうか確認

されます。 

 
ヒント！ 

 必ず、お使いのカメラに適したアップグレードファイルを使用してください。さもないと、

予期せぬ結果になることがあります。 

 アップグレードファイルは ZIP ファイルで、必要なファイルがすべて含まれているはずです。 

 起動プログラムがオペレーティングシステムをロードし、システムが動作を開始します。

デフォルトではアップグレード起動プログラムの機能は無効になっており、カメラは最新

バージョンにのみアップグレードされます。これを有効にすると、カメラと起動プログラ

ムがアップグレードされ、以下の新バージョンのオペレーティングシステムが適切に起動

し、カメラが容易にアップグレードできます。 

 アップグレード中は、確実に電源を接続しておいてください。アップグレードが完了する

と、デバイスは自動的に再起動します。 

 

システムの再起動 

1. [Setup] > [System] > [Maintenance] とクリックします。 

 

2. Device Restart で Restart をクリックします。操作を確定すると、デバイスが再起動します。  

 
注意！ 

システムを再起動すると現在実行中のサービスが中断するので、この操作は慎重に実行してくだ

さい。 

 

システム設定ファイルのインポートとエクスポート 

カメラの現在の設定をエクスポートして、PC または外部ストレージメディアに保存します。PCま

たは外部ストレージメディアに保存したバックアック設定をカメラにインポートすると、速やかに

設定を復元することができます。 
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注意！  

 デフォルト操作を実行すると、システム管理者のログインパスワード、ネットワーク設定、

システム時刻を除く設定が、すべて工場出荷時のデフォルト設定に復帰します。 

 お使いのカメラに適した設定ファイルをインポートしてください。さもないと、予期せぬ

結果になることがあります。 

 設定ファイルのインポートが成功すると、カメラが再起動します。 

 

1. [Setup] > [System] > [Maintenance] とクリックします。 

 

2. バックアップした設定をインポートするには、Import ボタンの横の Browse ボタンをクリック

し、インポートしたい設定を選択し、Import をクリックします。結果が表示されます。 

3. 現在のシステム設定をエクスポートするには、Browse （Exporting フィールドの横）をクリッ

クし、エクスポート先を設定し、Export をクリックします。 

4. デフォルト設定を復元するには、Default をクリックし、操作を確定します。デバイスが再起

動し、デフォルト設定に復帰します。チェックボックスを選択して Default をクリックすると、

デバイスは工場設定に完全に復帰します。 

診断情報の収集 

診断情報には、ログやシステム設定が含まれます。PC に診断情報をエクスポートすることができ

ます。 

1. [Setup] > [System] > [Maintenance] とクリックします。 

 

2. Diagnosis Info エリアで Browse をクリックし、エクスポート先を設定し、Export をクリックし

ます。 

 
ヒント！ 

 圧縮ファイルの形で、ローカルフォルダに診断情報がエクスポートされます。WinRAR な

どのツールでファイルを解凍 し、テキストエディタでファイルを開く必要があります。 

 Collect Image Debugging Info を選択すると、デバッグ情報のあるビデオが表示されるので、

故障診断が容易になります。 

フォーカス設定 

デバイスは、最小焦点距離に応じて、オートフォーカスの速度を調整することができます。対象物

を明瞭に撮影する際には、最小焦点距離を、対象物とレンズとの間の距離より短く設定します。た

とえば、最小焦点距離が 3m の場合、レンズから 3m 以内にある対象物には焦点が合わなくなります。 
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ヒント！ 

この機能は、オートフォーカス機能が実装されたデバイスでのみサポートされます。詳細につい

ては、実際のモデルをご覧ください。 

1. [Setup] > [System] > [Maintenance] とクリックします。 

 

2. Focus で Min. Focus Distance（単位：cm）と Max. Zoom Ratio を設定します。 

3. OK をクリックします。 

デバイス取付高さ 

ドームが自動的に赤外線ランプを調整できるように、地面からの実際の赤外線ドームの取付高さを

入力します。 

 
ヒント！ 

この機能は、一部の赤外線カメラでしかサポートされません。詳細については、実際のモデルを

ご覧ください。 

1. [Setup] > [System] > [Maintenance] とクリックします。 

 

2. 地面からの実際の赤外線ドームの取付高さを入力します。 

3. OK をクリックします。 

魚眼カメラパラメータ 

ビデオを適切に表示するには、実際の取付モードに応じて、魚眼パラメータを適切に設定する必要

があります。 

 
ヒント！ 

この機能は、一部の魚眼カメラでしかサポートされません。詳細については、実際のモデルをご

覧ください。 

 



77 

1. [Live View] > [Mount] とクリックします。取付モードを選択します。選択した取付モードが、

実際の取付モードと一致していなければなりません。 

 

カメラのモデルによっては、このページは次のように表示されます。 

 

 

2. パラメータを設定します。次の表に、主なパラメータが説明されています。 

パラメータ 説明 

 

 

 

 

11 種類のディスプレイモード： 

 オリジナル 

 パノラマ 

 パノラマ + 3PTZ 

 パノラマ + 4PTZ 

 パノラマ + 8PTZ 

 360° パノラマ + 1PTZ 

 180° パノラマ 



78 

パラメータ 説明 

 

 

 

 

 

 

 

 魚眼 + 3PTZ 

 魚眼 + 4PTZ 

 360° パノラマ + 6PTZ 

 魚眼 + 8PTZ 

 

 

 

3 種類の取付モード：  

 天井 

 壁面 

 デスクトップ 

注意：  

選択した取付モードが、実際の取付モードと一致していなければなりません。 

 

4  ライブビュー 

ライブビューとは、ウェブインターフェースを通じて、ウィンドウに、カメラからライブビデオ（リ

アルタイムの音声とビデオ）を再生することを意味します。 

Live View チェックボックスを選択してログインすると、デフォルトでは、ログイン時にライブビ

デオが表示されます。ウィンドウをダブルクリックすると、全画面表示をオンオフすることができ

ます。 
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ライブビューツールバー 

 
ヒント！ 

サポートされるライブビュー操作は、カメラのモデルによって異なることがあります。お使いの

カメラでサポートされる操作については、ウェブインターフェースをご覧ください。 

 

ボタン 説明 

/  ライブビューの再生と停止 

 

PC でメディアプレイヤーの出力音量を調整します。 

 

PC とカメラの間の音声通信で、PC のマイクの音量を調整します。 

 

現在 PC に表示されている画像のスナップショットを撮影します。 

注意：  

スナップショットの保存パスは System Configuration で設定されます。 

/  

ローカル録画を開始/終了します。 

注意：  

ローカル録画の保存パスは System Configuration で設定されます。 

/  PCとカメラの間の音声通信を開始/終了します。 

/  
デジタルズームを開始/終了します。詳細についてはデジタルズームの使用

を参照してください。 

/  
エリアフォーカスを開始/終了します。詳細についてはエリアフォーカスの

使用をご覧ください。 

/  
3D ポジショニングを開始/終了します。詳細については3D ポジショニング

の使用を参照してください。 

 PTZ コントロールパネルを表示/非表示します。 
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ボタン 説明 

 

ウィンドウで画像表示比率を設定します。たとえば、オリジナルの 

16: 9 で高解像度画像を表示するには、Scale を選択します。ウィンドウの

サイズに応じて表示するには Stretch を選択します。オリジナル画像サイズ

で表示するには Original を選択します。 

 

パケットロスレートをゼロにリセットします。 

注意：  

ライブビューウィンドウでカーソルを移動すると、浮動ツールバーにこの

ボタンが表示されます。 

 

ウィンドウ下部に、パケットロスレートとビットレートの情報が表示され

ます。 

注意：  

ライブビューウィンドウでカーソルを移動すると、浮動ツールバーにこの

ボタンが表示されます。 

このボタンをクリックすると、いつでも情報を表示することができます。

もう一度クリックすると、ウィンドウの上にカーソルを移動させたり下部

に配置したときにのみこの情報が表示されます。カーソルがウィンドウ上

で 3 秒間静止したり、カーソルがウィンドウの外に出ると、情報が非表示

になります。 

 
このボタンをクリックすると画像設定ページが開きます。 

 
全画面モードで表示されます。 

 

 

 

メインストリーム、サブストリーム、サードストリームの中から、カメラ

がサポートするライブビデオストリームを選択します。 

 

画像中の特定エリアの表示 

デジタルズーム、エリアフォーカス、3D ポジショニングによって、画像中の特定エリアを表示す

ることができます。デジタルズームでは、画質を犠牲にして画像が拡大されますが、3D ポジショ

ニングでは画質を悪化させずに拡大できます。 

デジタルズームの使用 

 
ヒント！ 

サポートされるライブビュー操作は、カメラのモデルによって異なることがあります。お使いの

カメラでサポートされる操作については、ウェブインターフェースをご覧ください。 
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1. Live Viewページのツールバーで  をクリックします。 

 

2. マウスのボタンを押しながら上から下へドラッグして（長方形を描いて）エリアを指定します。

オリジナル画像サイズを復元し画像の別の部分を拡大するには、マウスを右クリックします。 

3. 終了するには  をクリックします。 

エリアフォーカスの使用 

 
ヒント！ 

サポートされるライブビュー操作は、カメラのモデルによって異なることがあります。お使いの

カメラでサポートされる操作については、ウェブインターフェースをご覧ください。 

 

1. Live View ページのツールバーで  をクリックします。 
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2. マウスのボタンを押しながら上から下へドラッグして（長方形を描いて）エリアを指定します。 

3. 終了するには  をクリックします。 

3D ポジショニングの使用 

 
ヒント！ 

この機能は、ネットワーク PTZ カメラと、電動ズームレンズと PTZ が装備されたネットワークボ

ックスカメラでのみ利用できます。詳細については、実際のモデルをご覧ください。 

 

1. Live View ページのツールバーで  をクリックします。 

 

2. マウスのボタンを押しながら上から下へドラッグして（長方形を描いて）エリアを指定します。

逆に（下から上に）ドラッグすると、縮小されます。 

3. 終了するには  をクリックします。 

魚眼カメラのライブビュー 

 

ヒント！ 

 この機能はネットワーク魚眼カメラでしかサポートされません。詳細については、実際の

モデルをご覧ください。 

 ウェブ上でのプレビュー画像は、カメラの魚眼設定に応じて変化します。ライブビューを

開始する前に、魚眼カメラパラメータ（魚眼カメラパラメータを参照）とカメラの魚眼モ

ードを設定してください。  

ディスプレイモードには、主に、オリジナル画像、魚眼と PTZ、パノラマ＋PTZ の 3 つのモードがあ

ります。取付モードが異なると、画像の表示も異なります。以下の例では壁面取付を取り上げます。 

オリジナル画像を選択すると、次のように魚眼画像が表示されます。 
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パノラマを選択すると、次のように、歪曲補正されたパノラマ画像が表示されます。 
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ヒント！ 

天井取付やデスクトップ取付を採用した場合、パノラマ画像（2 枚の 180° 画像）は、魚眼プレビ

ュー画像（360° 画像）の歪曲補正画像になります。実際の監視要件に適した画角に、カメラを取

り付けてください。 

たとえば、天井に取り付けたカメラで、デバイスのケーブルアウトレット（ロゴ）と監視対象と

の間の交差角度が時計回りに 135° であった場合、監視対象はパノラマ画像の上部に表示されます。 

 

 

右のリストでパノラマ + 4PTZ プレビューモードが選択されると、デフォルトでは、左から右へ、

上から下へ、4 枚のローカル画像が表示されます。下図に示すように、各ローカル画像で、PTZ コ

ントロールとズーム操作を実行することができます。 

 

パノラマカメラの 5ePTZ 

 
ヒント！ 

一部のカメラモデルでのみこの機能がサポートされます。詳細については、実際のモデルをご覧

ください。自動追跡はメインストリームでのみサポートされます。 

 

監視対象の位置 

（アクセスコントロールなど） 

魚眼プレビューモードでの

360°魚眼画像 

パノラマプレビューモードで

のパノラマ画像 

対象 

ケーブ

ルアウ

トレッ

ト 
デバイス

底面 
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1. 下図に示すように、Live View ページでツールバー  を選択します。 

 

2. パノラマモードで  をクリックすると、ライブビューが 5ePTZ 追跡モードになります。す

るとカメラは、周辺保護機能が有効になっている場合にライブビューで動体を追跡します。さ

らに、同時に、最大 5 個まで、周辺保護機能で設定したアラームルーツをトリガーする対象物

を追跡して拡大することができます。この機能は、PTZ カメラの追跡・拡大機能と同様に動作

します。 

 

3. 5ePTZ 追跡モードで  をクリックするとパノラマモードに切り換わります。 
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5  エッジストレージによるビデオ再生とダウンロ
ード 

 
ヒント！ 

 エッジストレージとは、フロントエンドデバイス（ほとんどの場合カメラ）のメモリカー

ドへの録画を指しています。ローカル録画とはローカル PC クライアントへのビデオ録画

を指しています。 

 エッジストレージでビデオを再生する前に、カメラにメモリカードがインストールされス

トレージが設定されていることを確認してください。 

 この機能は一部のモデルではサポートされません。詳細については、実際のモデルをご覧

ください。 

 

ビデオ再生 

1. ホームページで Playback をクリックします。 

 

2. カレンダーから日付を選択します。 

3. Query をクリックします。 

4. Results で時間をダブルクリックすると録画の再生が開始します。 
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ダウンロード 

1. ホームページで Playback をクリックします。 

 

2. 指定時間内でビデオを検索します。リストに検索結果が表示されます。 

3. ビデオを選択し Download をクリックします。ビデオは、メモリカードからローカルパスにダ

ウンロードされます（ローカルパスは Local Settings で変更できます）。 

4. Open をクリックすると、ダウンロードされたビデオが保存されているフォルダが表示され

ます。 

6  PTZコントロール 

この機能は PTZ ドームカメラまたはパン/チルトモーターにインストールされたボックスカメラで

のみ利用できます。  

 
ヒント！ 

 レンズコントロール機能の一部は、電動レンズを搭載したカメラに適用されます。 

 PTZ コントロールボタンはカメラのモデルによって異なることがあります。お使いのカメ

ラでサポートされる PTZ コントロールボタンについては、ウェブインターフェースをご覧

ください。 

 

PTZコントロールツールバー 

項目 説明 

プリセット 

プリセットを選択して  をクリックします。PTZ カメラに、選択されたプリ

セットが適用されます。 

プリセットを追加するには  をクリックします。プリセットを削除するに 

は  をクリックします。 

パトロール 

パトロールルートを選択し  をクリックすると、パトロールを開始します。  

 パトロールルートを編集するには  をクリックします。 

 パトロールルートを追加するには  をクリックします。 

 パトロールルートを削除するには  をクリックします。 
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項目 説明 

 

PTZ カメラの移動速度を調整します。 

 

PTZ カメラの方向を制御し、コントロールをリリースします。 

/  

/  

/  

/  

/  

IR をオン/オフにします。 

ワイパーをオン/オフします。 

ヒーターをオン/オフします。 

照明をオン/オフします。 

スノーコントロールをオン/オフします。 

 

カメラのフォーカスを調整します。 

 

カメラのズームを調整します。 

 

絞り径を増減します。 

 

PTZ コントロールのショートカットキー。ライブビューでカーソルの形がこれ

らの形状のいずれかに変化したら、左マウスボタンを押しながら PTZ カメラを

操作します。 

注意：  

 PTZ ドームカメラと PTZ カメラのみがこの機能をサポートします。 

 3D ポジショニングまたはデジタルズームを使用している場合は、これらの

ボタンは使用できません。 

 

ライブビューにおける拡大縮小用ショートカットキー。ホイールを前方にスク

ロールすると拡大され、後方にスクロールすると縮小されます。 

注意：  

この機能は、電動ズームレンズを搭載したカメラでのみサポートされます。 

 

プリセットによるパトロールの設定 

プリセットの設定 

Preset タブで、プリセットを管理したり、PTZ カメラの制御操作を実行することができます。詳細

については PTZコントロールツールバーを参照してください。 
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プリセットの追加 

1. Live View ページのコントロールパネルで Preset をクリックします。 

 

2. 希望の方向を向くまでカメラを調整します。 

3. 最適な画像が得られるように、必要に応じてズームとフォーカスを調整します。 

4.  をクリックして、プリセットとして追加します。プリセットの番号と名前を入力し、OK を

クリックします。 

プリセットに進む 

1. Live View ページのコントロールパネルで Preset をクリックします。 

 

2. プリセットで  をクリックします。PTZ カメラに、選択されたプリセットが適用されます。 

1

2

3

4

1 2
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プリセットの削除 

1. Live View ページのコントロールパネルで Preset をクリックします。 

 

2. プリセットで  をクリックし、削除を確定します。 

パトロールの設定 

パトロールルートとは、1 つのプリセットから次のプリセットに移動したときに PTZ カメラがフォ

ローするトラックを指しています。PTZ カメラが各プリセットに滞在する時間を設定することがで

きます。1 台の PTZ カメラで複数のパトロールルートを設定することができます。 

パトロールアクションの例として、プリセットに進み、特定の時間 1 つのプリセットに滞在してか

ら次のプリセットに進む、などが挙げられます。回転方向、ズーム、回転速度、パトロール時間、

滞在時間を設定することができます。システムはルートを記録し、それをアクションリストに追加

します。Keep Rotating を選択すると、PTZ カメラは同じルートとパトロールを繰り返しフォローし

ます。 

1 2
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パトロールルートの追加 

1. Live View ページのコントロールパネルで Patrol をクリックします。 

 

2.  をクリックします。 

3. Add Patrol ページにルートの ID と名前を入力し、Add をクリックすると、パトロールアクショ

ンが追加されます。最大  64 個のアクションが追加できます。アクションタイプが 

Move Direction と Zoom に設定されると各ラインには 2 個のアクションが含まれます。すなわ

ち、32 個のアクションが許可されることになります。このボタンを使用してアクションの順番

を調整します。 

パトロールアクションの例：  

 プリセットに進み、1 つのプリセットに指定の時間滞在してから次のプリセットに進む。 

 設定速度で指定の時間、設定方向に回転する。拡大する。設定位置に指定の時間滞在する。 

Keep Rotating が選択されている場合、パトロールを繰り返す。 

最初のアクションタイプとして Go to Preset が推奨されます。 

4. OK をクリックします。 
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パトロールルートの記録 

1. Live View ページのコントロールパネルで Patrol をクリックします。 

 

2.  をクリックすると、パトロールルートの記録が開始されます。記録中に、カメラの方向や

ズームを調整することができます。システムはカメラの動きとトラックを記録し、それらをア

クションリストに追加します。 

3.  をクリックすると記録が終了します。すると、自動的に、モードルートとして、パトロー

ルルートが保存されます。  をクリックするとパトロールが開始し、  をクリックするとモ

ードルートが削除されます。 

 

1

2
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パトロールプランの作成 

1. Live View ページのコントロールパネルで Patrol をクリックします。 

 

2.  をクリックします。パトロールプランを設定するページが表示されます。 

3. パトロールの時間とルートを正しく設定します。 

4. Enable Patrol Plan を選択します。 

5. OK をクリックします。 

パトロールルートの開始 

パトロールルートを追加した後で、パトロールルートを選択するとパトロールが開始しします。 

1. Live View ページのコントロールパネルで Patrol をクリックします。 

 

2. 開始したいパトロールルートで  をクリックします。 

1

2

1

2
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パトロールルートの編集 

1. Live View ページのコントロールパネルで Patrol をクリックします。 

 

2. 編集したいパトロールルートで  をクリックし、必要に応じて設定を変更します。 

パトロールルートの削除 

1. Live View ページのコントロールパネルで Patrol をクリックします。 

 

2. 削除したいパトロールルートで  をクリックし、削除を確定します。 

1
2

1
2
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ホームポジションの設定 

指定時間内に操作されなかった場合、PTZ カメラはホームポジションに戻ります。 

 
ヒント！ 

 この機能はネットワーク PTZ カメラでのみ利用できます。 

 まず、プリセットまたはパトロールルートを追加する必要があります。詳細については、プリセ

ットの追加とパトロールルートの追加をご覧ください。 

 

1. [Setup] > [PTZ] > [Home Position] とクリックします。 

 

2. モードと ID を選択します。 

3. Save をクリックします。 

PTZのリモートコントロール 

サードパーティプラットフォームが使用されているが PTZ プロトコルがそれにマッチしない場合、

リモートコントロール機能を設定して PTZ を制御することができます。 

 
ヒント！ 

この機能は PTZ カメラでしかサポートされません。 

 

1. [Setup] > [PTZ] > [Remote Control] とクリックします。 

 

2. On を選択して Remote Control を有効にします。リスナーポートとアドレスコードを設定しま

す。次の表に、主なパラメータが説明されています。 

頭字語 説明 

リスナーポート 
未使用のカメラのローカルポートをリスナーポートにすることができ

ます。必要な場合にのみ、デフォルト設定を変更します。 

アドレスコード 

カメラは、指示に記載されているアドレスコードのみを読み取ることが

できます。カメラは、指示中のアドレスコードがここで設定されている

アドレスコードである場合にのみ、指示を翻訳します。 

 

3. Save をクリックします。 
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PTZの限界 

PTZカメラが壁面などの障害物と衝突しないように、回転限界を設定します。 

 
ヒント！ 

この機能は一部の PTZ カメラでしかサポートされません。 

 

1. [Setup] > [PTZ] > [PTZ Limit] とクリックします。  

 

2. 方向ボタンを使用して、希望の位置にカメラを回転します。 

3.  をクリックして、現在位置を限界に設定します。たとえば、上部の  をクリックすると、

上限が設定されます。  をクリックすると、方向が変化した場合に、現在の位置までカメラ

が回転します。 

4. 必要に応じて上の手順を繰り返して、全部の限界（上下左右）を設定します。 

5. Save をクリックします。 

6. Start PTZ Limit をクリックすると、設定が適用されます。 

7.  をクリックすると、設定が削除され、限界がリセットされます。 

パトロールの再開 

1. [Setup] > [PTZ] > [Patrol] とクリックします。 

 

2. パトロールが再開される時刻を設定します。 

3. Save をクリックします。 

1

2

3

4
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7  LPR （ナンバープレート識別） 

 
ヒント！ 

 この機能は一部のモデルのみで利用できます。 

 

LPR ライブビュー 

1. マイクロ SD カードがインストールされているカメラでは、SD カードにスナップショットが保

存されます。SD カードがインストールされていない場合、スナップショットは PC に保存され

ます。Open Image Folder をクリックすると、スナップショットが表示されます。左上のペイン

にプレートのクローズアップ画像が表示されます。 

2. Clear All Records をクリックすると、スナップショットの記録がクリアされます。 

 

LPR の設定 

検知エリアの設定 

1. [Setup] > [Intelligent] > [Traffic Monitoring] とクリックします。Draw Detection Rules をクリック

します。 
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2. Draw Detection Rules をクリックし、スナップショットに検知エリアを描きます。 

 

3. Inclination Line をクリックし、路面の傾斜を示す傾斜線を描きます。 

 

フローカウントのリセット 

[Setup] > [Intelligent] > [Traffic Monitoring] > [Smart] > [Reset Flow Counting] とクリックします。

LPRスナップショットをリセットする時刻を設定します。 

 

スマートスナップショット処理 

[Setup] > [Intelligent] > [Traffic Monitoring] > [Snapshot Handling] とクリックします。通常はデフ

ォルト設定が推奨されます。 
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未確認車両：未確認車両を通過記録を作成するか否かを選択します。デフォルトではこの機能

が起動しています。 

写真生成：プレートのクローズアップ画像を表示するか否かを選択します。デフォルトでは、

画像が表示されるように設定されています。 

写真 

[Setup] > [Intelligent] > [Traffic Monitoring] > [Photo] とクリックします。このページでスナップ

ショット OSD を設定します。 

 

 

項目 説明 

1 枚の写真 
フォントの色：OSD テキストの色です。 

背景色：OSD 背景色です。 

フォントサイズ フォントサイズを設定します。 

文字スペース OSD 文字間のスペースを設定します。  

時間フォーマット 時間フォーマットを設定します。 

日付フォーマット 日付フォーマットを設定します。 

OSD 項目 

OSD 項目を選択します。 

項目を選択すると、下表を編集して各項目のOSD 設定の詳細を記入

することができます。 
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付録 A 用語集 

頭字語 説明 

ARP アドレス解像度プロトコル 

CBR 固定ビットレート 

DNS ドメイン名サービス 

DDNS ダイナミックドメイン名サービス 

DHCP ダイナミックホスト設定プロトコル 

DST 夏時間 

FTP ファイル転送プロトコル: 

GOP 画像集合体 

GUI グラフィックユーザインターフェイス 

HTTPS ハイパーテキスト・トランスファー・プロトコル・オーバー SSL 

IE インターネットエクスプローラー 

IMOS IP マルチメディアオペレーションシステム 

IP インターネットプロトコル 

IPC IP カメラ 

MTU 最大伝送単位 

NTP ネットワーク時間プロトコル 

OSD オンスクリーンディスプレイ 

PoE パワー・オーバー・イーサネット 

PPPoE 
ポイント・トゥ・ポイント・プロトコル・オーバー・イーサネッ

ト 

PTZ パン、チルト、ズーム 

ROI 関心領域 

SMTP シンプルメール転送プロトコル 

SSL セキュアソケットレイヤー 

UNP ユニバーサルネットワークパスポート 

USB ユニバーサルシリアルバス 

VBR 可変ビットレート 

WDR ワイドダイナミックレンジ 
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付録 B よくある質問 

初めて Windows 7 PC でログインしたときに、ActiveX をインストールするよう指示するメッセージが

表示されないのですが、どうしたらよいですか 

回答：次の手順で UAC をオフにし、再度ログインしてください。  

1. Start ボタンをクリックし、Control Panel をクリックします。 

2. 検索ボックスに uac と入力し、Change User Account Control Settings をクリックします。  

3. スライダーを Never Notify の位置に動かし、OK をクリックします。  

4. UAC がオフになったら、再度ログインします。 

 

ActiveXのインストールに失敗しましたが、どうしたらよいですか 

回答：インストールが失敗したら、次のように、信頼できるサイトとしてカメラの IP アドレスを

追加します。IE で Internet Option を開き、Security タブをクリックし、Trusted sites をクリックし、

Sites をクリックしてウェブサイトを追加します。 

Windows 7 を使用する場合、まず PC に setup.exe を保存し、ファイルを右クリックし、 

Run as administrator を選択し、指示に従ってインストールします。 

 

初めてログインしたときにライブビデオが表示できませんでしたが、どうしたらよいですか 

回答：PC のファイヤーウォールを閉じ、ウェブインターフェースに再度ログインしてください。 


